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Einleitung 
Schon seit einigen Jahren werden digitale Spiegelreflexkameras (DSLR) in der 
Amateurastronomie zur Messung der Helligkeiten von Himmelsobjekten wie 
veränderlichen Sternen oder Kleinplaneten eingesetzt. Seit der Publikation der 
Anleitungen von (Hassforther 2008, 2009) und (Wischnewski 2011) ist nun bereits einige 
Zeit vergangen, in der die Entwicklung in der digitalen fotografischen Technik gewaltige 
Fortschritte gemacht hat. Moderne CMOS-Chips bieten inzwischen standardmäßig 
Auflösungen von 16-24 Megapixel und eine gesteigerte Lichtempfindlichkeit, die selbst 
für lichtschwache Deep-Sky-Objekte Belichtungszeiten von nur wenigen Sekunden 
erlaubt. 
 
Zudem sind die Preise für Digitalkameras mit Wechselobjektiven, also digitale 
Spiegelreflexkameras (DSLR für digital single-lens reflex) und teilweise auch schon 
spiegellose Systemkameras (DSLM für digital single lens mirrorless) so weit gesunken, 
dass sich die Verwendung von Kompaktkameras bei der Veränderlichenbeobachtung 
kaum mehr lohnt. Ein besonderer Vorteil dieser Kameras ist, dass man bereits 
vorhandene oder preisgünstig erhältliche Objektive aus dem Analogzeitalter verwenden 
kann. 
 
Eine Anleitung neueren Datums, mit einer Fülle von Informationen, ist bislang nur auf 
Englisch verfügbar (The American Association of Variable Star Observers 2016). Als 
Neulinge in der Thematik der Veränderlichenbeobachtung möchten die Autoren ihre 
Erfahrungen, aber auch Irrwege in deutscher Sprache weitergeben, um künftigen 
Einsteigern die Einarbeitung in die Thematik zu erleichtern. Sehr profitiert haben wir von 
Diskussionen auf der Mailingliste der BAV, sowie teilweise daran anschließenden 
Diskussion im privaten Email-Verkehr. Allen unseren Helfern gilt unser aufrichtiger 
Dank. 
 
Wie unsere Vorgänger möchten wir kostengünstige Möglichkeiten der 
Veränderlichenbeobachtung aufzeigen. Daher werden wir auch nicht auf Astrokameras 
und große stationäre Stative und Montierungen eingehen, sondern uns auf einfache, 
transportable Modelle beschränken. Im ersten Teil unseres Berichtes möchten wir die 
erforderliche Ausrüstung (Kameras, Objektive, Stative, Nachführung) vorstellen. Im 
zweiten Teil wird beschrieben, wie die Aufnahmen anzufertigen sind. Im dritten Teil 
behandeln wir die Auswertung, angefangen von Informationen zu den veränderlichen 
Sternen, wo man diese findet, wo und wie man seine Daten weitergeben und wie man 
eine möglichst hohe Messgenauigkeit erzielen kann. 
 
 
 
 
 
 



Teil 1: Die Ausrüstung 
 
Kameras 
Welche Kamera für die Beobachtung von Veränderlichen gewählt wird, dürfte in den 
meisten Fällen davon abhängen, welche Ausrüstung bereits vorhanden ist. Prinzipiell 
sind alle DSLRs und DSLMs für die Beobachtung von Veränderlichen geeignet. Wichtig 
ist lediglich, dass die Bilder im RAW-Format abgespeichert und ausgewertet werden. 
Trotzdem gibt es gewichtige Unterschiede. Bei den in der Astrofotografie weit 
verbreiteten Canon-Kameras können dank ihres Auflagemaßes von 48,00 mm (dem 
Abstand zwischen Bildsensor und Befestigungsfläche des Objektivs) über Adapter die 
allermeisten Objektive anderer Hersteller verwendet werden. Die bei Biologen und 
Geografen beliebten Nikon-Kameras (Anschluss: Nikon F) weisen hingegen ein 
Auflagemaß von 46,50 mm auf. Dies macht es schwierig Fremdobjektive zu verwenden. 
Zwar existieren mit Ausgleichslinsen versehene Adapter, diese vermindern aber die 
Bildqualität. Bei normaler Fotografie ist dies meist belanglos, nicht aber bei 
Sternaufnahmen, die auch kleine Linsenfehler aufzeigen. So werden die eigentlich 
punktförmigen Sterne zu kleinen, in die Mitte gerichteten Strichen verzogen 
(Astigmatismus). Daher sollten möglichst nur linsenlose Adapter verwendet werden. 
Diese haben aber, speziell bei Nikon-Kameras, den Nachteil, dass der Fokuspunkt für 
die Einstellung „unendlich“ nicht erreicht wird, weil das Auflagemaß nicht mehr stimmt. 
Um trotzdem Fremdobjektive verwenden zu können, ist mehr oder minder aufwändige 
Bastelarbeit nötig. Manchmal genügt es eine oder mehrere Madenschrauben zu lösen, 
um den Unendlichkeitspunkt neu einzustellen. Bei Pentacon-Teleobjektiven ist der 
Adapter für M42 oder das Exakta-Bajonett über eine Schraubverbindung (Pentacon 
Sixt, Mittelformat) mit dem Objektiv verbunden. Dieser Adapter lässt sich mit einem 
gewissen Aufwand umarbeiten. Mit etwas Glück erhält man einen solchen Adapter für 
den gewünschten Kameratyp auch über den Online-Handel. 
 
DSLMs besitzen ein sehr kurzes Auflagemaß (das Z-Bajonett von Nikon z.B. nur 16 
mm), was es erlaubt, nahezu alle Analogobjektive linsenlos an diese Kameras 
anzuschließen. 
Die von uns vorwiegend eingesetzten Kameras waren die Canon EOS M5 (DSLM), die 
Nikon Z50 (DLSM) und die Nikon D3300 (DSLR). Die D3300 ist das bei weitem 
günstigste 24-Megapixel-Modell von Nikon, besonders wenn man sie auf dem 
Gebrauchtmarkt erwirbt. Beide Kameras sind Leichtgewichte (unter 500 g), was für 
mobile Nachführungen oder auch bei Fokalaufnahmen an einem Teleskop ein deutlicher 
Vorteil ist. 
 
Objektive 
Für die Sternfotografie gibt es eine klare Empfehlung: möglichst nur Festbrennweiten 
und keine Zoomobjektive verwenden! Als optimale Lösung sind Makroobjektive zu 
empfehlen, da diese meist eine sehr gute Bildqualität aufweisen. Allerdings sind sie 
auch recht teuer. Die Kosten übertreffen oftmals diejenigen eines einfachen Teleskops. 
 
Moderne DSLR-Objektive haben Ihren Fokuspunkt für die Einstellung „unendlich“ nicht 
am Anschlag, sondern davor. Dies ist aufgrund der Autofokusfunktion notwendig. Für 
Astroaufnahmen ist der Autofokus aber grundsätzlich abzustellen. 



Fokussiert werden muss im Life-View-Modus. Einer Scharfstellung im Sucher einer 
DSLR ist unzureichend. Sehr komfortabel ist hingegen der elektronische Sucher einer 
DLSM. Besonders bei Kurzbrennweiten-Objektiven ist der Fokuspunkt sehr schwer 
einzustellen, da die Objektive nicht über ausreichend Spiel verfügen. Das betrifft 
insbesondere die modernen, elektronischen (Autofokus-)Objektive. Bei den alten 
analogen Objektiven ist es etwas besser. Teleobjektive, vor allem jene über 200-300 
mm, lassen sich meist besser fokussieren. Zum einen, weil die Sterne aufgrund des 
größeren Linsendurchmessers heller erscheinen und daher meist deutlicher erkennbar 
sind, zum anderen, weil der Sterndurchmesser auf dem Sensor meist deutlich größer 
als bei einem Normalobjektiv ist. Ein Abblenden der Objektive um mindestens 2 
Blendenstufen ist auf jeden Fall zu empfehlen. Selbst qualitativ sehr hochwertige 
Objektive, wie das unten genannte Tokina-Objektiv, zeigen bei Offenblende 
Abbildungsfehler, wie Koma, Astigmatismus und chromatische Aberration. Diese 
Abbildungsfehler können durch Abblenden deutlich vermindert werden (vgl. (Legault 
2019, S. 148–150)). Auch wurde bei dem genannten Objektiv bei einer zu geringen 
Abblendung auf 3.5 festgestellt, dass die Sterne auf einer Bildseite scharf sind, während 
sie auf der anderen Seite als Donuts dargestellt wurden. Bei Abblendung auf 4.5 war 
der Abbildungsfehler hingegen gerade noch erträglich. Der eine Autor (JS) blendet 
daher zumeist auf 5.6 ab, auch wenn dies zu Lasten des nutzbaren 
Objektivdurchmessers und damit der darstellbaren Grenzgröße geht. Ein nützlicher 
Nebeneffekt der Abblendung ist die Vermeidung einer Vignette, so dass man sich 
theoretisch ein Weißbild sparen kann. 
 
Von großem Vorteil ist eine Objektivheizung, die günstig erworben werden kann und ein 
Beschlagen oder Bereifen der Optik verhindert. Der Stromanschluss erfolgt über einen 
USB-Adapter. Eine leistungsfähige Stromquelle, möglichst Netzanschluss, ist dafür aber 
zu empfehlen. 
 
Die folgenden Objektive wurden bezüglich ihrer Eignung geprüft: 
 
Tokina AT-X Pro Macro 100 F2.8 D (JS): Dieses Objektiv hat sich als absoluter Favorit 
erwiesen. Die Sterne bleiben bis zum Rand punktförmig. Blendet man auf Blende 5.6 
ab, so hat man keine erkennbare Vignettierung und erspart sich ein Weißbild (Flat, siehe 
Teil 2). Ein weiterer Vorteil ist die Möglichkeit, den Fokuspunkt für „unendlich“ durch 
Heraus- oder Hereinschrauben der hinteren Linse auf Anschlag (entweder perfekt 
scharf oder leicht defokussiert, passend für die Photometrie) einstellen zu können. Das 
steigert die Effizienz des Aufnahmevorgangs deutlich. Dies wurde zufällig entdeckt, als 
nach einigen Monaten Nutzung die Aufnahmen langsam immer unschärfer wurden. So 
hat sich dieses Manko im Nachhinein als Vorteil erwiesen. Laut diversen Testberichten 
haben die 100-mm-Makroobjektive verschiedener Hersteller ähnliche gute Qualitäten, 
allerdings zahlt man für Originale der Kamerahersteller oft das Doppelte. Produkte von 
Sigma, Tamron und Tokina sind in Qualität und Preis hingegen vergleichbar. 
 
Tamron SP 60mm F/2 Macro: Das Tamron 60-mm-Makroobjektiv zeigte ähnlich gute 
Abbildungseigenschaften wie das AT-X Pro. Als rein elektronisches Objektiv hat es aber 
bei manuellem Gebrauch sehr wenig Spiel, so daß der Schärfepunkt nur schwer 
einstellbar ist. Auch ist der Unendlichkeitspunkt nicht fixierbar. Daher erwies es sich 



gegenüber dem 100-mm-Objektiv in puncto Effizienz bei der Erfassung veränderlicher 
Sterne als unterlegen. 
 
AF-S Micro Nikkor 40mm 1:2,8 G: Das Nikon 40mm-Macroobjektiv wies subjektiv 
deutlich schlechtere Abbildungseigenschaften als die beiden zuvor genannten Objektive 
auf. Tests ergaben, dass die Messgenauigkeit deutlich geringer als jene des 100-mm-
Objektivs war. 
 
Nachfolgend sind einige preisgünstige Objektive genannt: 
Revuenon-Special 1:2.8/135mm: Bei diesem Objektiv mit M42-Anschluß kann der 
Unendlichkeitspunkt problemos durch Lösen einer Madenschraube verstellt werden. Die 
Abbildungseigenschaften sind recht gut, ein Astigmatismus ist nur leicht ausgeprägt. 
 
Pentacon 4/200: Bei diesem Objektiv konnte durch Entfernen des abschraubbaren 
Exakta-Adapters und Ankleben eines Nikon-Adapters der Unendlich-Fokuspunkt an die 
D3300 angepasst werden. Die Abbildungseigenschaften sind sehr gut, die Sterne auch 
am Rand nicht verzogen. 
 
Pentacon 4/300: Für dieses Objektiv stand ein linsenloser Nikon-F-Adapter zur 
Verfügung. Das 300-mm-Pentacon-Objektiv zeigt hervorragende Abbildungs-
eigenschaften, ist allerdings sehr schwer und benötigte eine entsprechend 
leistungsfähige Nachführung wie die Omegon LX3. Allerdings tritt auch in diesem Falle 
aufgrund des hohen Gewichtes bei höherer Stellung des angepeilten Gestirns ein 
„durchrutschen“ des Aufbaus am Kugelkopf häufig auf. Dieses Problem haben wohl alle 
Astrotracker (Pröschold 2021). Besser ist es daher dieses schwere Objektiv huckepack 
auf einem Teleskop zu verwenden. 
 
Pentacon 5.6/500: Dieses Objektiv gleicht von den Ausmaßen einem Teleskop. Leider 
war die Abbildungsqualität trotz linsenlosem Adapter unzureichend. Am Bildrand zeigten 
sich die Sterne x-förmig verzerrt. 
Die genannten Objektive wurden von dem einen Autor (JS) an der Nikon D3300 erprobt. 
 
Der andere Autor (VW) setze mit Erfolg die folgenden Festbrennweiten-Objektive mit 
PK-Bajonett an der Canon EOS M5 ein: 
 
50 mm 1:1,9 AUTO-REVUENON 
135 mm 1:2,8 AUTO- REVUENON  
200 mm 1:3,5 AUTO REVUENON  
 
Stativ 
Für die Astrofotografie im Allgemeinen und die Beobachtung veränderlicher Sterne im 
Besonderen ist nicht unbedingt ein extrem stabiles Stativ notwendig. Ein Aluminium-
Dreibeinstativ von 1-2 kg Gewicht ist völlig ausreichend. Dabei ist darauf zu achten, 
dass es über genügend Tragkraft verfügt. 5 Kilogramm sollte es für Kamera, Objektiv, 
Stativkopf und gegebenenfalls Nachführung schon tragen können. Bei manchen 
einfachen Stativen sind die Befestigungen für die Kamera aus Kunststoff. Solche 
Ausführungen sind nicht sehr geeignet. 



Sehr zu empfehlen ist ein 3-Wege-Neiger sowie ein Stativ-Kugelkopf. Auch hier ist auf 
eine stabile Ausführung zu achten. 
 
Nachführung 
Möchte man sich nicht auf kurz belichtete Aufnahmen von 1-4 Sekunden beschränken, 
so ist eine Nachführung notwendig. Als relativ preisgünstige Lösungen bieten sich 
sogenannte Reisemontierungen an. Dabei gibt es sowohl strombetriebene als auch rein 
mechanische Modelle. Wir möchten hier (lediglich) unsere Erfahrungen mit den von uns 
eingesetzten Modellen wiedergeben. 
Seit einiger Zeit gibt es von der Marke Omegon eine rein mechanische Nachführung. 
Diese wird wie ein Uhrwerk aufgezogen und läuft maximal eine Stunde. Es sind derzeit 
(Stand Februar 2021) zwei Versionen im Handel. Die LX2 Min Track ist in der Lage, bis 
zu 2 kg Zuladung zu tragen, die LX3 schafft 3 kg. Das geringe Gewicht von 730 g (LX2) 
bzw. 650 g (LX3) erleichtert das Tragen von Stativ und Montierung an einen günstigen, 
von Störlicht wenig beeinflussten Platz. Mit einem Preis von 129,- Euro sind diese 
Montierungen deutlich günstiger, als eine strombetriebene Lösung. Allerdings wird die 
LX3 derzeit nur in Verbindung mit einem Polsucher angeboten, der ihren Preis auf 189,- 
Euro verteuert. Nutzt man die Mini Tracks nur für kurz belichtete Einzelaufnahmen von 
10 bis maximal 30 Sekunden, also jenen Belichtungszeiten, die sich ohne die 
Dauerbelichtungs-Funktion an DSLR/DSLMs einstellen lassen, so sind selbst bei 
Optiken mit 300 mm Brennweite die Sterne noch punkförmig, obgleich der Hersteller 
eine Brennweite von maximal 100 mm empfiehlt. 
 
Die Ausrichtung auf den Polarstern ist selbst bei der LX2, die ohne einen Polsucher 
geliefert wird, mit einiger Übung schnell und genau möglich. Der eine Autor (JS) nutzt 
die LX2 seit April 2019 sowie die LX3 seit Oktober 2020 und möchte sie bei der 
Beobachtung veränderlicher Sterne nicht mehr missen. Allerdings seien auch ihre 
Schwächen nicht verschwiegen. Zum einen die Beschränkung auf maximal eine Stunde 
Nachführzeit, wobei die Nachführung je nach Stellung auch öfters einmal früher stehen 
bleibt. Besonders in Zenitstellung hat die Nachführung ausgesprochene 
Schwierigkeiten, ihre Zuladung zu bewegen. Zwar ersetzt eine Spannfeder funktionell 
ein Gegengewicht, aber selbst in extremster Stellung schafft es die LX2 nicht immer, 
das Gewicht der Kameraausrüstung zu tragen, wenn diese zenitnah ausgerichtet ist, 
selbst wenn die Zuladung deutlich unter 2 kg liegt. Eine leichte Kameraausrüstung ist 
auf jeden Fall vorteilhaft. 
 
Bei der LX3 sind diese Probleme aufgrund ihrer höheren Tragkraft deutlich abgemildert 
(aber nicht völlig beseitigt) und die Einstellungsmöglichkeiten der Spannfeder 
vielfältiger. Dadurch bedingt erfordert es aber deutlich mehr Erfahrung, bei jeder 
Positionierung die richtige Einstellung zu finden. Fazit: Für die fotografische Erfassung 
langperiodischer Veränderlicher sind die Mini Tracks ein hervorragendes Hilfsmittel, für 
durchgehende Lichtkurven bei kurzperiodischen Sternen sind sie hingegen nicht ganz 
so gut geeignet, wenngleich eine Neuausrichtung auf den Zielstern nach einer Stunde 
Laufzeit (besser früher) in wenigen Sekunden erledigt ist. 
Eine Übersicht verschiedener Astrotracker findet sich bei (Pröschold 2021). 
 
 
 



Fernauslöser 
Fernauslöser zur erschütterungsfreien Auslösung der Kamera gibt es in verschiedenen 
Ausführungen. In puncto Verlässlichkeit hat sich ein einfacher, kabelgebundener 
Auslöser ohne Sonderfunktionen am besten bewährt. Will man jedoch mehr als 9 
Aufnahmen in Serie auslösen, üblicherweise die maximal mögliche Zahl bei Betätigung 
des kamerainternen Selbstauslösers, so muss man einen Timer einsetzen. Leider 
gehen diese Geräte nach einiger Zeit leicht kaputt (Kabelbrüche?) und müssen ersetzt 
werden. Angesichts des relativ günstigen Preises ist dies aber zu verschmerzen. Nicht 
bewährt haben sich Infrarot-Fernauslöser. Hier gab es zu oft Ausfälle. 
 
Zu beachten ist, den Selbstauslöser mit ca. 20 Sekunden Vorlaufzeit zu programmieren 
(dies war bei der D3300 der maximal mögliche Wert), um die Wahrscheinlichkeit von 
Nachschwingungen und damit verwackelten Aufnahmen zu vermindern. 10 Sekunden 
waren oft nicht ausreichend. 
Grundsätzlich ist es besser, den kamerainternen Selbstauslöser zu verwenden, auch 
wenn die maximale Anzahl der Bilder einer Serie auf 9 beschränkt ist, da die Gefahr von 
Bedienfehlern gegenüber einem externen Timer deutlich vermindert ist. Die Kamera 
wählt automatisch die richtigen minimalen Abstände zwischen den Bildern, wohingegen 
es bei Benutzung eines externen Timers durchaus vorkommen kann, dass ein Bild 
ausgelassen wird, wenn das Abspeichern zu lange gedauert hat. 
Die DSLM Z50 von Nikon besitzt keinen Anschluss für einen Fernauslöser. Hier ist man 
auf die Bluetooth-Variante angewiesen. Die Timer-Funktionen sind in der Kamera 
integriert und recht komfortabel, so dass man den fehlenden Anschluss verschmerzen 
kann. 
 
Die hier beschrieben Kombinationen haben sich bei den Autoren bei der Beobachtung 
veränderlicher Sterne sehr bewährt: sie sind blitzschnell einsatzbereit, z. B. bei 
Wolkenlücken und der Aufnahmeort kann gleichfalls schnell gewechselt werden. 
 
Teil 2: Die Aufnahmen 
 
Einstellungen der Kamera 
Bereits oben wurde erwähnt, dass die Kamera auf RAW-Format eingestellt sein muss. 
Zudem sind sämtliche kamerainternen Verarbeitungen, soweit möglich, abzuschalten. 
Dies gilt insbesondere für Rauschreduzierung bei Langzeitbelichtung und High-ISO-
Rauschreduzierung. 
Obwohl auch ohne Nachführung mit sehr hohen ISO-Einstellungen (bis 25.600) bei sehr 
kurzen Belichtungszeiten (1-4 Sekunden) brauchbare Aufnahmen erstellt werden 
können, zeigten Testreihen und Empfehlungen in diversen Foren, dass die ISO-Zahl 
möglichst gering eingestellt werden sollte. De Facto ergab sich bei unterschiedlichen 
ISO-Einstellungen nach der Bearbeitung der Dateien (z.B. mit Fitswork) oft ein ähnliches 
Rauschen der Einzelaufnahmen. Die Farbwiedergabe war jedoch bei niedrigen ISO-
Zahlen deutlich besser. 
 
Um die Übertragung von Zeitangaben zu erleichtern, wurden die eingesetzten Kameras 
von dem einen Autor (JS) auf UTC (koordinierte Weltzeit) umgestellt. Etwa alle 2 
Wochen oder noch besser am Tag vor einer geplanten Aufnahmeserie, wird die 
Kamerazeit mit der Zeit einer Atomuhr über das Internet verglichen und gegebenenfalls 



korrigiert. Die Abweichungen betrugen im Zeitraum von 2 Wochen bei der einen D3300 
ca. 4 Sekunden, bei der anderen nicht einmal eine Sekunde. Die kamerainterne Uhr 
kann also selbst bei gleichen Modellen von Kamera zu Kamera variieren. 
 
Es ist sinnvoll, die Länge der Aufnahmezeiten für eine Einzelaufnahme auf maximal 30 
Sekunden und die Anzahl der Aufnahmen auf 9 Bilder je Aufnahmeserie zu 
beschränken. Dies sind jene Werte, die sich mit dem eingebauten Selbstauslöser einer 
DSLR/DSLM maximal realisieren lassen. Der Einsatz eines externen Timers hat sich 
bei kurzen Bilderserien (bis ca. 10 Aufnahmen) nicht bewährt, da die Gefahr sehr groß 
ist, durch falsche Einstellungen entweder wertvolle Aufnahmezeit zu verlieren (wenn die 
Wartezeit zwischen den Aufnahmen zu lange gewählt wird) oder durch zu kurze 
Intervalle einzelne Aufnahmen zu verlieren, so dass die Aufnahmeserie zu klein wird. 
Bei Verwendung der Bulb-Funktion ist zudem nicht gewährleistet, dass die durch einen 
externen Timer einprogrammierte Aufnahmezeit exakt stimmt. Verwendet man 
hingegen die systeminternen Einstellungen, so muss man sich um die exakten Werte 
nicht weiter kümmern, da diese von der Kamera geregelt werden. Lediglich für 
Serienaufnahmen, wie sie bei kurzperiodischen Veränderlichen erforderlich sind, lohnt 
es sich der Einsatz eines externen Timers. Allerdings haben höherwertige Kameras (wie 
die D7200, D90 oder Z50 von Nikon) auch interne Funktionen, die dieses erlauben. Sie 
sind jedoch nicht immer so „pflegeleicht“ zu realisieren, wie die Aufnahmezeiten (in den 
Abstufungen 1, 1.3, 1.6, 2, 2.5, 3, 4, 5, 6, 8, 10, 13, 15, 20, 25 und 30 Sekunden) und 
die Zahl der Serienaufnahmen (1-9). 
 
Durch Abblenden auf 5,6 erspart man sich oft ein Weißbild, also eine Flatframe-
Korrektur. Eine Darkframe-Korrektur hingegen ist meist notwendig, da viele Kameras 
ein deutliches Verstärkerglühen am Rand aufweisen. 
 
Es empfiehlt sich stets nur wenige, gleichen Aufnahmeparameter zu verwenden. 
Aufgrund des Szintillationsrauschens sollten kurze Belichtungszeiten von unter einer 
Sekunde vermieden werden (Wischnewski 2021, S. 59). 
Je nach Himmelshintergrund empfehlen sich für ein 100-mm-Makroobjektiv, 
abgeblendet auf Blende 5.6, folgende Einstellungen: 
Für die Mehrheit der Sterne zwischen Größenklasse 6 und 12: ISO800, 10 Sekunden 
Belichtungszeit, 9 Einzelaufnahmen je Objekt, also eine Gesamtbelichtungszeit von 1,5 
Minuten 
In klaren, mondlosen Nächten kann die ISO-Zahl, bei gleicher Belichtungszeit, auf 6400 
gesteigert werden, je nach Rauschverhalten der Kamera kann es auch eine höhere oder 
geringere ISO-Zahl sein. Mit ISO 6400 lassen sich in günstigen Nächten Objekte bis 
herunter zu Größenklasse 14,0 nachweisen. 
Für helle Objekte zwischen Größenklasse 3 und 8 ist der minimal mögliche ISO-Wert 
(üblicherweise ISO 100) in Kombination mit einer Belichtungszeit der Einzelaufnahmen 
von 5 Sekunden zu empfehlen. 
Durch die kurz belichteten Einzelaufnahmen (10 Sekunden) wird vermieden, dass die 
Sterne in die Sättigung geraten. Die Summenbilder werden im 32-Bit-Gleitkomma-Fits-
Format gespeichert, damit keine Information verloren geht und die Sterne auch bei der 
Aufsummierung der Helligkeitswerte beim Stacking nicht gesättigt werden. 
Außerdem ist der Verlust von Einzelaufnahmen, bedingt durch Meteore, Flugzeug- und 
Satellitenspuren bei nur 10 Sekunden Belichtungszeit leichter zu verschmerzen. Sind 



diese Lichtspuren sehr hell, so stören sie die Sternerkennung bei der späteren 
Auswertung mit Muniwin (siehe unten) und müssen daher entfernt werden. Entweder 
durch Retusche oder durch Löschen der betroffenen Aufnahme. 
 
Dunkelbilder (Darks) 
Neben den Aufnahmen seiner Zielobjekte, in unserem Fall veränderlicher Sterne, 
benötig man noch sogenannte Dunkelbilder (Darkframes oder Darks). Das sind 
Aufnahmen, die bei abgedecktem Objektiv mit derselben Belichtungszeit, ISO-Zahl und 
Umgebungs(Chip)-Temperatur wie die Objektaufnahmen (Lightframes oder Lights) 
angefertigt werden. Mit den Dunkelbildern wird das thermisch bedingte Signal ermittelt. 
Das sind zum einen helle und dunkle Pixel, sogenannte Hot- und Coldpixel, die Sterne 
vortäuschen oder ihre Helligkeit verändern und zum anderen das Verstärkerglühen, das 
meist an einer oder zwei Bildseiten auftritt und dort eine rötliche Aufhellung bewirkt. Es 
empfiehlt sich für jede genutzte Kombination aus den drei Parametern ISO-Zahl, 
Belichtungszeit und Umgebungstemperatur (36-)45 Aufnahmen zu erstellen. Aus diesen 
wird dann ein sogenanntes Masterdark errechnet, das von den Objektaufnahmen 
abgezogen wird. 
Diese Dunkelbildarchive sollten möglichst einmal im Jahr erneuert werden, sind aber 
ansonsten immer wieder einsetzbar (Wischnewski 2021, S. 194). 
Bei Belichtungszeiten bis zu einer Sekunde ist das thermische Rauschen so gering 
ausgeprägt, dass kein Dunkelbildabzug erforderlich ist (Legault 2019, S. 50). 
In Ausführungen über Astrofotografie wird auch noch ein Biasbild (Bias) erwähnt, dass 
gleichfalls abzuziehen ist. Darauf müssen wir aber nur achten, wenn wir sowohl Dunkel- 
als auch Weißbilder abziehen. Falls wir nur Dunkelbilder abziehen, ist das Bias bereits 
darin enthalten, andernfalls müssen wir dafür sorgen, dass es nur einmal abgezogen 
wird, weil es auch im Weißbild (nächster Abschnitt) enthalten ist. 
 
Weißbilder (Flats) 
Neben dem thermischen Signal sollten auch noch die Vignettierung (Bildabschattung 
am Rande) sowie Verschmutzungen des Sensors ausgeglichen werden. Dies geschieht 
durch sogenannte Weißbilder (Flatframes oder Flats), welche mit exakt der gleichen 
Ausrichtung zwischen Kamera und Objektiv wie die Objektaufnahmen angefertigt 
werden müssen, das heißt, die aufgesetzte Optik darf nicht verdreht werden. Auch die 
Blende muss identisch sein, die Belichtungszeit bzw. der ISO-Wert kann hingegen so 
angepasst werden, dass die Belichtung 25(-50)% vom Histogrammwert abdeckt. 
Wichtig ist zudem, dass die Fläche einheitlich ausgeleuchtet wird. Andernfalls 
verschlechtert ein Flat bei photometrischen Messungen diese sogar, was auch durch 
eigene Messungen (JS) bestätigt wurde. Aus diesem Grund empfiehlt (Wischnewski 
2021, S. 201) entweder die Verwendung von Leuchtfolie oder auf ein Flat zu verzichten. 
Als Ausweg bietet es sich an, die eingesetzten Objektive um 2-3 Blendenstufen 
abzublenden. Wird z.B. ein 100-mm-Objektiv mit einer Blende von 1:2.8 auf Blende 5.6 
abgeblendet, so ist keinerlei Vignettierung mehr erkennbar. Bei solchermaßen 
abgeblendeten Objektiven rechtfertigt die immer vorhandene Sensorverschmutzung 
allerdings durchaus die Verwendung von Flats. Bei der Verwendung von Fotoobjektiven 
ist es nicht mehr nötig, die wertvolle nächtliche Aufnahmezeit zu „vergeuden“. Daher 
wird die Kamera nach den Aufnahmen mit noch immer montierter Optik nach der 
Aufnahmeserie in einen dunklen Raum gleichmäßiger Temperatur verbracht und die 
Flats werden am nächsten Morgen angefertigt. Dies hat gegenüber der sofortigen 



Anfertigung eines Flats den Vorteil, dass die Chiptemperatur einen in etwa konstanten 
Wert, nämlich Zimmertemperatur, aufweist, so dass immer dieselben Flatdarks 
verwendet werden können und eine hohe Anzahl von Flats (Autor JS fertigt jeweils bis 
45 an) zeitlich kein Problem bereiten. Die Verwendung von Flatdarks ist nur in Fitswork, 
nicht aber in Muniwin möglich, erlaubt aber eine weitere Steigerung der 
Messgenauigkeit um den Faktor 10 (Wischnewski 2021, S. 201). 
Bei der Verwendung von Fotoobjektiven ist es nicht mehr nötig, die wertvolle nächtliche 
Aufnahmezeit zu „vergeuden“. Vielmehr wird die Kamera-Objektivkombination nach den 
Aufnahmen in einen dunklen Raum gleichmäßiger Temperatur gebracht. Dort werden 
dann die Flats aufgenommen. Dies hat zudem den Vorteil, dass man stets die gleichen 
Flatdarks verwenden kann und eine hohe Anzahl von Flats (Autor JS fertigt jeweils bis 
45 an) zeitlich kein Problem bereitet. 
Hat man keine Leuchtfolie zur Verfügung, bietet sich folgende Vorgehensweise an (VW): 
2-3 Lagen weißes Kopierpapier auf die Optik legen und diese auf eine gleichmäßig 
beleuchtete Zimmerdecke richten (vgl. auch (Legault 2019, S. 52). 
Es gibt auch die Möglichkeit einer rechnerischen Korrektur der Vignettierung (nicht aber 
der Sensorverschmutzung). Programme wie Adobe Lightroom (Adobe o. J. [2021b]) 
bieten solche Möglichkeiten, die wir jedoch nicht ausprobiert haben. 
Während ein Dunkelbildabzug auf jeden Fall erforderlich ist, ist der Flatabzug 
Ermessenssache (Wischnewski 2021, S. 1369). 
 
 
Teil 3: Auswertung 
 
Referenzsterne  
Möchte man die Helligkeitsveränderung eines Sternes vermessen, so benötigt man 
Referenzsterne, deren Helligkeiten genau vermessen wurden. Hierfür gibt es vor allem 
2 Empfehlungen: 
 
1. Der Variable Star Plotter der AAVSO (The American Association of Variable Star 
Observers o. J. [2021d]) 
Der Variable Star Plotter ist nur auf Englisch verfügbar. Man gibt zunächst einen 
veränderlichen Stern (erst die Bezeichnung, dann das Sternbild, z. B. CC And) oder 
bestimmte Himmelskoordinaten ein (Konvention: siehe online-Hilfen unmittelbar unter 
den Eingabefeldern) und wählt dann eine Bildgröße aus 8 vordefinierten Stufen aus. Es 
empfiehlt sich mit einer Übersichtskarte (A) zu beginnen. Diese stellt eine Umgebung 
von 15 Grad dar und zeigt Sterne bis zur Größenklasse 9. Das entspricht der Breite 
einer DSLR-Aufnahme mit einem 85-mm-Objektiv. Detailliertere Karten zeigen 
schwächere Sterne. Die Grenzgrößenklasse wie auch der Bildausschnitt lassen sich bei 
den advanced options auch verändern. Wählt man aber zu schwache Sterne so können 
diese in einer von der Webseite vorgegebenen Zeit nicht dargestellt werden. Der 
Vorgang wird dann abgebrochen und man erhält eine entsprechende Warnmeldung. 
Dieses Problem tritt aber nur auf, wenn man eine Karte (Option Chart) drucken möchte. 
Wenn man eine Liste der Vergleichssterne erhalten möchte (Option Photometry) kann 
man ohne weiteres, selbst im Übersichtsmodus (A), Sterne bis zur 16. Größenklasse 
oder schwächer ausgeben lassen. Auf diese Weise kann man sich systematisch eine 
Datenbank mit Vergleichssternen für bestimmte Himmelsregionen herunterladen. 
Wichtig ist auch die Ausrichtung. Für fotografische Aufnahmen ist CCD zu wählen, das 



bedeutet Norden oben und Westen rechts. Visual hingegen stellt die Sterne so dar, wie 
sie in einem Teleskop mit Umkehrprisma erscheinen (reversed). 
 

 
 
Bei den advanced options kann man die Ausrichtung gleichfalls den eigenen Wünschen 
anpassen. Man kann außerdem einen eigenen Titel und Bemerkungen über die Karte 
drucken lassen. Je nach Wahl des (veränderlichen) Zielsterns erscheinen dessen 
Eigenschaften (Parameter), wie Sterntyp, Periode und Helligkeitsamplitude gleichfalls 
auf der Karte. Hilfreich sind noch zwei weitere Optionen: What Other Variable Stars 
Should Be Marked? ist in der Grundeinstellung auf none gesetzt. Wählt man hier GCVS 
oder all, so werden die jeweils verfügbaren veränderlichen Sterne im Himmelsausschnitt 
angezeigt. Das kann sehr hilfreich sein, da man vielleicht einen weiteren interessanten 
Stern entdeckt, den man gleichzeitig mit dem eigenen Zielstern zusätzlich erfassen 
möchte. Die Option yes bei Would You Like All Magnitude Labels To Have Lines? ist 
vor allem bei Übersichtskarten hilfreich, damit man erkennt welcher Vergleichsstern 
jeweils gemeint ist. 
 



 
 
Klickt man nun auf den Knopf mit der Bezeichnung Plot Chart, so wird entweder die 
gewählte Karte oder eine Photometrietabelle für die darauf vorhandenen 
Vergleichssterne ausgegeben. Jede auf der Webseite angezeigte Karte bietet einen 
Link zur zugehörigen Photometrietabelle und jede Photometrietabelle einen Link zur 
zugehörigen Karte an. Die Karte kann man durch Rechtsklick mit der Maus (Grafik 
speichern unter) auf dem eigenen PC abspeichern, die Tabelle kann man markieren, 
über Copy/Paste in ein Tabellenkalkulationsprogramm (z.B. Excel (Microsoft o. J. 
[2021])) kopieren und dort abspeichern. Achtung: wird bei Select which filters to display 
(Photometry Only) kein Farbfilter gewählt, so wird nur das V-Band und B-V ausgegeben. 
 



 
 
Auf den Karten sind dann die Vergleichssterne mit ihren Helligkeiten in 
Zehntelmagnituden bezeichnet (label, z.B. 107 für 10,7 mag). Diese Darstellung ist kurz 
und übersichtlich, besonders bei Übersichtskarten sind aber meist mehrere Sterne mit 
derselben Bezeichnung vertreten und es ist bisweilen eine längere Suche erforderlich, 
um die korrekten Werte für einen bestimmten Vergleichsstern zu ermitteln. Dann 



empfiehlt es sich einen nahen Veränderlichen zu suchen oder die Koordinaten leicht zu 
variieren und eine neue Karte größeren Maßstabs auszudrucken. 
 
Während die auf den Karten sichtbaren Helligkeitssignaturen für visuelle Beobachter 
ausreichen, müssen für Messungen (CCD- oder Digitalkamera) die Datentabellen 
herangezogen werden. Jeder Vergleichsstern der AAVSO hat einen bestimmten Code 
(AUID), den man bei der späteren Meldung (siehe unten) für Referenz(Comp)- und 
Prüf(Check-)sterne angeben kann. Neben den Koordinaten enthalten die 
Photometrietabellen hinter den Helligkeitsangaben in Klammern noch deren 
Genauigkeit. 
 

 



2. Das Programm Cartes du Ciel, auch Skychart genannt (Chevalley o. J. [2020]). Es 
ist in mehreren Sprachen, auch auf Deutsch verfügbar. In der Version 4 ist der Gaia 
DR2-Katalog eingebunden, welcher sehr genau gemessene Sternhelligkeiten enthält. 
Das Programm rechnet diese zudem automatisch und korrekt in die visuellen 
Helligkeiten um. Die Genauigkeit der auf das UBVRI-System nach Johnson-Kron-
Cousin umgerechneten Helligkeiten beträgt 0,046 mag (Wischnewski 2021, S. 609). 
 

 
 



Weitere Helligkeitsangaben sind über Verlinkung z.B. mit Simbad (Centre de Données 
astronomiques de Strasbourg o. J. [2021]) abrufbar. 
 

 
 
„Entwicklung“ der Bilder 
Ebenso wie man früher Bilder im Labor entwickeln musste, erfordert die Digitalfotografie 
eine Aufbereitung (Kalibrierung) der Bilder, die funktionell dem Entwickeln entspricht. 
Zum einen müssen die Bilder durch Subtraktion eines Masterdarks vom thermischen 
Rauschen befreit werden und gegebenenfalls werden durch Division mit einem 
Masterflat Vignettierung und Sensorverschmutzung ausgeglichen. 
Möchte man ein Farbbild erhalten, so müssen die einzelnen Farbkanäle extrahiert 
werden. Dabei ist es wichtig zu wissen, wie der Sensor einer Digitalkamera aufgebaut 
ist, nämlich aus winzigen Fotodioden, die jeweils abwechselnd Filter für die Farben Rot, 
Grün und Blau besitzen. Bei dieser sogenannten Bayer-Matrix besitzt jede zweite Diode 
einen Filter für den Grünkanal und jeweils jede vierte einen Filter für den Blau- bzw. 
Rotkanal. Daraus ergibt sich logisch, dass Messungen im Grünkanal wesentlich 
genauer möglich sind, als in den anderen beiden Farbkanälen. Auch erfolgt die 
Scharfstellung im Grünkanal, so dass sich speziell im Blaukanal höherer Unschärfe und 
damit geringere Messgenauigkeiten ergeben (Wischnewski 2021, S. 262). Ein weiterer 
Aspekt für die geplante Photometrie ist, dass Digitalkameras üblicherweise Infrarot- und 
Ultraviolett-Sperrfilter besitzen, die auch einen Teil des sichtbaren Lichtes aussperren. 
Während der Grünkanal einer Digitalkamera recht gut der visuellen Helligkeit (V-Band) 
und der Blaukanal recht gut dem B-Band entspricht (Wischnewski 2021, S. 1039), ist 
das bei Rotkanal und R-Band bei Kameras mit Sperrfiltern nicht der Fall. 
Aus den Informationen der Leuchtdioden wird in einem mehr oder minder komplizierten 
Rechenverfahren (Debayering) ein Farbbild (RGB) extrapoliert. Dieses Bild ist zudem in 
beiden Dimensionen üblicherweise doppelt so groß wie das ursprüngliche Rohbild 
(RAW). 



Welches Programm sich zur Entwicklung der Bilder empfiehlt, ist davon abhängig, ob 
man kurzperiodische Veränderliche messen möchte, bei denen die gesamte Messreihe 
in einer Nacht abgeschlossen wird oder langperiodische Veränderliche, bei denen man 
Aufnahmen aus verschiedenen Nächten auswerten muss. 
Verwendet man moderne DSLR- oder DSLM-Kameras, so erzeugen diese Bilder von 
mehreren Megapixeln Größe. Verwendet man zudem das Rohformat, kann man von 
dieser Bildgröße nicht abweichen. Bedauerlicherweise sind nicht alle 
Photometrieprogramme in der Lage, mit solchen Dateigrößen umzugehen. Aus diesem 
Grund werden nachfolgen nur zwei Programme besprochen, die mit den Daten unserer 
24-Megapixel-Kameras zurechtkamen. Das waren Fitswork und Muniwin.  
 
Fitswork 
Fitswork (Dierks o. J. [2014]) ist primär kein Photometrieprogramm, sondern es wurde 
zur Optimierung von Bildern bei der Astrofotografie entwickelt. Es enthält aber auch 
Module für astronomische Auswertungen, so zur PSF-Photometrie (Wischnewski 2021, 
S. 269–270) und zur Speckle-Interferometrie (Wischnewski 2021, S. 409–410). 
Verfügbar ist es auf der Webseite von Klaus Hohmann (Dierks o. J. [2014]), wo auch 
Anleitungen und Tipps zu finden sind (Hohmann o. J. [2021a]). Der interessierte Leser 
sei auf die genannte Webseite verwiesen. Es lohnt sich wirklich, die Möglichkeiten 
dieses außerordentlich gut programmierten astronomischen Hilfsmittels zu erkunden. 
Die Verwendung von Fitswork empfiehlt sich vor allem bei langperiodischen 
Veränderlichen und ist daher dort beschrieben. 
 
Muniwin 
Muniwin (Motl o. J. [2021]) ist ein sehr mächtiges Programm, das speziell für die 
Photometrie von Zeitreihen entwickelt wurde. Es bietet sehr viele Möglichkeiten, die 
auszuschöpfen aber eine eingehende Beschäftigung erfordert. Eine gute Einführung in 
die Grundfunktionen gibt Wischnewski (Wischnewski 2021, S. 270–277). 
Allerdings ist Muniwin für die Auswertung rauscharmer Aufnahmen mit Astrokameras 
optimiert. Verwendet man stattdessen DSLR/DSLMs, die, besonders bei höheren ISO-
Zahlen, ein stärkeres Rauschen aufweisen, so kommt es zu der paradoxen Situation, 
dass die Messungen bei unkalibrierten Aufnahmen eine höhere Genauigkeit aufweisen 
als Aufnahmen, bei denen ein Dark- und/oder Flatabzug durchgeführt wurde. Die 
Kalibrierung erhöht nämlich das Rauschen. Ein Ausweg ist es die Belichtungszeit zu 
erhöhen, um das Rauschen zu vermindern und zugleich zu defokussieren, um zu 
verhindern, dass die Pixelwerte der Sterne in die Sättigung kommen. Leider erhöht sich 
bei verlängerter Belichtungszeit auch die Wahrscheinlichkeit von störenden 
Leuchtspuren (Meteore, Satelliten, Flugzeuge). 
Es gibt jedoch eine wesentlich elegantere Lösung: die Anwendung eines Rauschfilters. 
Bei dem in Fitswork integrierten Rauschfilter (Glätten -> Rauschfilter) wurde mit den 
Werten Schwelle = 60-80 und Radius = 5 eine ca. siebenfache Erhöhung der 
Messgenauigkeit erzielt. Der Wert für Gauss-Cauchy wurde in der Defaulteinstellung 
(ca. 54) belassen. 
Warum ist der Rauschfilter so wichtig? Aufgrund der Sternerkennungsfunktion von 
Muniwin. Bei kalibrierten und damit verrauschten Aufnahmen missinterpretiert Muniwin 
Unregelmäßigkeiten im Hintergrund als Sterne. Bei zu niedrigem FWHM-Wert in den 
Einstellungen (siehe unten) erkennt Muniwin anstelle hellerer Sterne ganze 
Sternhaufen. Diese Pseudosterne werden dann oft fehlerhaft gematcht, so dass die 



Messung der Helligkeit nicht immer im Zentrum erfolgt, sondern mal am Rande, mal im 
Zentrum. Logischerweise schwanken die Messwerte dann stark. Die Situation lässt sich 
durch Erhöhung des Filter Width (FWHM)-Wertes (bei Fokalaufnahmen mit Teleskopen 
durchaus auf 20, bei Fotoobjektiven auf ca. 6) abmildern, ein wirklicher Durchbruch in 
der Messgenauigkeit erfolgt jedoch erst durch die Anwendung eines Rauschfilters. 
Der Rechenaufwand für den Rauschfilters ist allerdings beträchtlich. Daher empfiehlt es 
sich, nicht Originalaufnahmen zu verwenden, sondern den interessierenden Bereich mit 
dem Veränderlichen und den Vergleichssternen auszuschneiden und den Rauschfilter 
erst vor der Messung auf diesen Ausschnitt anzuwenden (siehe auch unten, Kapitel 
„Bildüberlagerung“. Zu erwähnen ist noch, dass beide Programme auch mit kurzen 
Strichspuren zurechtkommen, so dass auch nicht perfekt nachgeführte Aufnahmen 
bearbeitet werden können. 
 
Zu wählendes Dateiformat 
Als Eingabeformat ist in allen Fällen das RAW-Format der jeweiligen Kamera zu wählen, 
die entsprechenden Dateien besitzen die Endung CR2 bei Canon und NEF bei Nikon-
Kameras. Sowohl Fitswork wie auch Muniwin kommen mit beiden Formaten zurecht. In 
Unkenntnis dieser Tatsache wurden von einen Autor (JS) anfangs die RAW- (NEF)-
Dateien in das DNG-Format von Adobe umgewandelt, welches als neuer Standard für 
Rohformate angepriesen wird (Adobe o. J. [2021a]; Wikipedia o. J. [2021]). Aus diesen 
DNG-Dateien wurden in Adobe Lightroom (Adobe o. J. [2021b]) 16-Bit-TIF-Dateien 
erzeugt, mit welchen in Fitswork die Kalibrierung der Bilder durchgefügt wurde. Diese 
über den TIF-Umweg erzeugten RGB-FITS-Dateien wiesen jedoch zwei gravierende 
Nachteile auf: 
 

1. Da das Debayering vor dem Darkabzug erfolgte, ließ sich das 
Verstärkerglühen nicht vollständig entfernen, sondern nur abmildern. 

 
2. Obwohl alle Informationen zur Aufnahme (Belichtungszeit, Optik, ISO-Zahl, 

Aufnahmedatum und -zeit) auch bei den TIF-Dateien noch immer als Exif-
Daten verfügbar sind, konnte Fitswork diese nicht mehr auslesen. Als 
Aufnahmedatum und -zeit übernahm das Programm vielmehr den Zeitpunkt 
der Formatumwandlung von DNG in TIF. Die anderen Parameter wurden gar 
nicht übernommen. Daher mussten diese separat in einer Datenbanktabelle 
verwaltet werden. Falls hingegen NEF oder DNG-Dateien verwendet werden, 
wird der FITS-Header korrekt geschrieben. Voraussetzung für ein korrektes 
Erkennen des NEF-Formates ist jedoch, dass die neueste Version der Datei 
dcrawfw.dll im Programmverzeichnis von Fitswork vorhanden ist. 

 
Muniwin ist ebenfalls in der Lage, NEF-Dateien zu lesen, nicht jedoch das DNG-Format. 
Die Extraktion des Grünkanals und seine weitere Verarbeitung war bei Verwendung von 
NEF-Dateien in Muniwin einfacher als wenn dieser mit Hilfe von Fitswork aus einer 
RGB-FITS-Datei extrahiert wurde. 
 
FITS-Format ist nicht gleich FITS-Format 
Für die Speicherung und Archivierung astronomischer Daten hat sich das von der NASA 
entwickelte FITS-Format (Flexible Image Transport System) durchgesetzt. Es ähnelt 
dem TIF-Format, das als Untermenge des FITS-Formates betrachtet werden kann. 



Leider gibt es zahlreiche Varianten und nicht alle Programme zur astronomischen 
Bildbearbeitung kommen mit allen zurecht. Zunächst einmal gibt es das 16- und 32-Bit-
Ganzahlformat und das 32-Bit-Gleitkommaformat. Lediglich das letztgenannte arbeitet 
verlustfrei (Wischnewski 2021, S. 204) und garantiert, dass beim Aufsummieren von 
Helligkeitswerten beim Stacking die Sterne nicht in die Sättigung geraten, also einzelne 
Pixel den höchstmöglichen Wert bekommen. Solche Bilder sind dann nur noch 
eingeschränkt photometrisch auswertbar. 
Als ob das nicht schon genug wäre, unterscheiden sich die Bilder auch noch in der Zahl 
der Ebenen. Farbbilder (RGB) enthalten 3 Ebenen, Rohbilder (RAW) nur eine. Manche 
Programme wie Muniwin können nur Bilder verarbeiten, die eine Ebene enthalten. Hat 
man als Ausgangspunkt ein RGB-FITS-Bild, so muss erst ein Kanal extrahiert werden, 
damit Muniwin diese Bilder akzeptiert. 
 
Auswertung von Fotoserien kurzperiodischer Veränderlicher 
Möchte man einen kurzperiodischen Veränderlichen photometrieren, hat also 
Aufnahmen einer einzigen Nacht vorliegen, so ist es am effizientesten, alle Arbeiten mit 
Muniwin zu erledigen. 
Zunächst einmal wird die Hauptmaske des Programmes vorgestellt. Die Erklärungen 
finden sich im Text wieder. Für die im Text beschriebene Menüpunkte gibt es jeweils 
spezifische Icons. 
 

 



Die erstellten Sternaufnahmen gliedern sich, wie weiter oben erläutert, in Lights, Darks 

und Flats. 

 

Als erstes wird ein Masterflat erstellt. Unter -> Project ->New project wird ein 
ausdrucksstarker Dateiname vergeben, etwa in der Form 
[Sternbild]_[Stern]_[Datum]_flat, z. B, And_CC_20201218_flat, und -> Master flat frame 
angeklickt, -> OK. 
 

 
 
Die Flats werden unter -> Frames -> Add individual frames, > Aufrufen des 
entsprechenden Speicherortes in der entsprechenden Dateiablage und markieren der 
Flats über Betätigen von -> Add in ein Unterverzeichnis des Projektordners mit Namen 
Projektname.cmpack-files kopiert. Die obersten 2 Fenster werden wieder geschlossen. 
Nun werden die Rohbilder über -> Reduce -> Express reduction oder Fetch/convert files 
und Auswahl von -> Green (G1-G2)/2 -> OK in das muniwin-eigene Format 
umgewandelt.  
 



 
 
Mit -> Make -> Master flat frame wird das Masterflat erstellt und der oben genannte 
Speicherort wird zur Speicherung ausgewählt. Das Masterflat wird im Anschluss 
angezeigt. 
 
Ähnlich wird bei der Erstellung des Masterdarks verfahren: 
Unter -> Project -> New project wird ein Dateiname z.B. And_CC_20201218_dark 
eingegeben und -> Master dark frame ausgewählt. Die Darks werden unter -> Frames -
> Add individual frames, Aufrufen des entsprechenden Speicherortes in der 
entsprechenden Dateiablage und Markieren der Darks über Betätigen von -> Add 
geladen. Die obersten 2 Fenster werden wieder geschlossen. Nun werden die Rohbilder 
wieder wie oben über -> Reduce -> Express reduction in das muniwin-eigene Format 
umgewandelt. Mit -> Make -> Master dark frame wird analog das Masterdark erstellt. 
 
Nun werden die eigentlichen Bilddateien (Lights) vorbereitet.  
Zur Erstellung einer Lichtkurve stehen viele Lights, hier 232 Dateien, zur Verfügung. 
Diese werden wie Flats und Darks geladen. Erneut wird unter -> Project -> New project 
ein Dateiname z.B. And_CC_20201218 eingegeben und diesmal -> Light curve 
ausgewählt. 
 
Die Lights werden wieder unter -> Frames -> Add individual frames, Aufrufen des 
entsprechenden Speicherortes und Markieren der Lights über Betätigen von -> Add 
geladen. 
 

 
 



Die obersten 2 Fenster werden wieder geschlossen. Nun werden die Rohbilder über -> 
Reduce -> Express reduction in gleicher Weise wie Flats und Darks in das muniwin-
eigene Format umgewandelt.  
 
Um die Uhrzeit der Aufnahmen noch zu korrigieren und z.B. in UTC umzuwandeln, 
werden unter -> Reduce -> Time correction mehrere Möglichkeiten angeboten. Die 
Aufnahmezeit der endgültig erzeugten Datei soll ja nicht in MESZ oder MEZ, sondern in 
UTC angezeigt werden. Aber auch im Nachhinein festgestellte Fehler in der Uhrzeit der 
Aufnahmekamera können hier korrigiert werden. 
 

  
 
Nun werden die Lights dark- und flat-korrigiert. Über -> Reduce -> Dark correction wird 
der Dateispeicherort des Masterdarks ausgewählt und mit -> Execute bestätigt. Die 
Lights werden automatisch dark-korrigiert. Gleichartig wird mit der Flat-Korrektur 
verfahren. Über -> Reduce -> Flat correction wird der Speicherort des Masterflats 
ausgewählt und mit -> Execute bestätigt. Die dark-korrigierten Lights werden nun noch 
flat-korrigiert. 
 
Nun folgt ein recht sensibler Bereich. Die eigentliche Photometrie, die 
Lichtstärkemessung, ist von vielen Aufnahmeparametern abhängig. Die Kamera mit 
ihren spezifischen Pixel-Abmessungen und die Aufnahme-Optik (Normal-Brennweite, 
Teleobjektiv oder Teleskop) spielen bei der Abbildung von Sternscheibchen eine große 
Rolle. 
 



Wurden die Frames mit DSLR / DSLM und Fotoobjektiven geringer Brennweite, hier 135 
mm, erstellt, so sollte auf eine Einstellung besonders hingewiesen werden: 
 
Unter -> Project -> Edit project settings -> Matching -> Matching algorithm werden 3 
Möglichkeiten angeboten. Der Menüpunkt -> Algorithm for dense fields muss hier 
angewendet werden. Beim Matching wird jedes Foto mit einem Referenzfoto verglichen. 
Da auf Aufnahmen mit Fotoobjektiven sehr viel mehr Sterne zu sehen sind, als auf 
Aufnahmen, welche mit einem Teleskop erstellt wurden, wird mit dieser Menüoption 
erreicht, dass die Sterne besser identifiziert werden. Vielfach ist ein erfolgreiches 
Matching überhaupt nur mit dieser Option möglich. 
 

 
 
Unter -> Reduce -> Photometry werden zuerst unter -> Process -> all files in current 
project alle Bilder ausgewählt. Unter der Registerkarte -> Photometry options werden 
die Parameter für die verschiedenen Blenden, welche bei der hier angewendeten 
Blendenfotometrie Verwendung finden, eingestellt. Da bei kurzbrennweitigen 
Fotoobjektiven (unter 200 mm) die Sternscheibchen sehr klein sind, kann es sinnvoll 
sein, die 12 Blenden auf Werte zwischen 1,00 und 7,00 Pixel zu verteilen. Entsprechend 
können die Werte für den Hintergrundring auf 10 und 15 Pixel reduziert werden. Die 
genauen Werte sind von der Sternhelligkeit, der Schärfeeinstellung und den 
Wetterbedingungen abhängig. Je lichtschwächer die zu messenden Sterne sind und je 
schärfer fokussiert wurde, desto kleiner sind die Werte zu wählen. Demgegenüber 
können bei defokussierten Aufnahmen und bei nebeligem Wetter mit damit verbundener 
stärkerer Lichtstreuung größere Werte gewählt werden. Die voreingestellten Werte 
(Defaultwerte) sollten aber nicht zu weit überschritten werden. 
 



 
 
Auf der Registerkarte -> Star detection können die Parameter zu Erkennung von 
Sternen auf einem Foto eingestellt werden. Unter Gaussian filter > Filter width (FWHM) 
wird die durchschnittliche Größe der Sternscheibchen angegeben. Bei defokussierten 
oder mit einem Rauschfilter behandelten Aufnahmen sollte dieser Wert erhöht werden. 
Wurden die Lights mit einer der oben aufgeführten DSLRs oder DSLMs gewonnen oder 
kamen gar gestackte FITS-Bilder (siehe unten Kapitel Bildüberlagerung) zum Einsatz, 
so kann die Einstellung unter -> Minimum brightness Detection threshold von 4 (default) 
auf Werte zwischen 8 und 16, nicht selten auch auf 50 und höher, eingestellt werden, 
damit die Anzahl der gefundenen Sterne sinnvoll begrenzt wird. Hier empfehlen die 
Autoren die der Kamera-Optik-Kombination betreffenden spezifischen Einstellungen 
selbst zu ermitteln. Man kann zudem die Anzahl der maximal ermittelten Sterne 
begrenzen (Constraints Max.stars). Hier empfehlen die Autoren eine Verringerung auf 
5.000 oder bei Bildausschnitten sogar 500 Sterne. 
 
Muniwin identifiziert Sterne auf den Aufnahmen in der Reihenfolge absteigender 
Helligkeit. Untersuchungen des Autors JS haben gezeigt, dass es vorteilhafter ist, den 
Detection-Threshold-Wert zunächst in der Grundeinstellung (4) zu belassen und 
zunächst einmal den Wert für Filter Width (FWHM) zu erhöhen und zudem die Anzahl 
der maximal ermittelbaren Sterne (Max.stars) zu begrenzen. Hat man sehr sternreiche 
Bildserien, so kann es vorteilhaft sein, den interessierenden Bildausschnitt (ROI = region 
of interest) auszuschneiden und für die Berechnungen diese kleineren Bilder zu 



verwenden. Diese Vorgehensweise ist weiter unten in dem Kapitel zur Bildüberlagerung 
beschrieben. 
Ein weiterer Parameter sollte bei DSLR/DSLM-Aufnahmen auch noch verändert 
werden: Maximum sharpness ist auf 4.00 zu erhöhen. Dies hilft bei der Erkennung sehr 
scharf eingestellter Sterne, die sonst von Muniwin als Störungen klassifiziert und 
ignoriert werden. 
 

 
 
Beim nun folgenden Matching unter -> Reduce / -> Match stars werden alle Fotos mit 
einem Referenzbild verglichen und ermittelt, wie groß die Übereinstimmung der 
gefundenen Sterne auf den vielen Fotos ist. Als Referenzbild sollte nach Möglichkeit 
jenes Bild gewählt werden, auf dem die meisten Sterne erkannt wurden. Zudem sollte 
es frei von Störungen, wie Wolken oder Flugzeug- oder Satellitenspuren sein. Durch 
Anklicken kann ein beliebiges Bild als Referenzbild ausgewählt werden. Im Beispiel ist 
es das Frame 70. 
Die soeben im Einzelschrittmodus erklärten Schritte können auch über Reduce -> 
Express reduction im Rahmen einer Stapelverarbeitung zusammen erledigt werden. 



 
 
Für die Erstellung einer Lichkurve geht es nun über -> Plot -> Light curve -> all files in 
current project weiter. Unter -> Light curve options kann hier auch die heliozentrische 
Korrektur (Compute heliocentric correction) und eine Beeinflussung der Luftmasse 
(Compute air mass coefficient) Berücksichtigung finden. Ebenso kann die Ausgabe in 
instrumentellen Magnituden erfolgen (show raw instrumental magnitudes), wenn die 
Helligkeiten später in kalibrierte Magnituden umgerechnet werden sollen. Dazu werden 
diese Felder angehakt und die weiter untenstehenden 6 Felder mit Inhalt gefüllt. Einmal 
der Name und die Koordinaten des Veränderlichen und einmal der Observationsort mit 
seinen Koordinaten. Diese Werte können auch im Programm über Betätigen von -> 
More gespeichert werden. Der eigene Wohnort kann dabei auch als Standard-
Observationsort -> Project settings -> Observer voreingestellt werden. 
 



 
 
Durch das Markieren von -> Ensemble photometry wird die Verwendung mehrerer 
Referenzsterne aktiviert. Zur Erstellung eine Lichtkurve wird die Seite Plot light curve 
mit -> Apply abgeschlossen. 
 



 
 
Jetzt erscheint ein dark- und flat-korrigiertes Bild, auf dem nun Veränderliche, 
Vergleichssterne und Checksterne markiert werden können (Choose stars). Um die 
verschiedenen photometrischen Messungen eines Veränderlichen miteinander 
vergleichen zu können, sollten immer gleiche Referenz- und Checksterne benutzt 
werden. Die Seite Choose stars wird nun mit -> OK beendet. 
 
Mit Hilfe des VSP (The American Association of Variable Star Observers o. J. [2021d]) 
und CdC (Chevalley o. J. [2020]) (siehe oben, Kapitel Referenzsterne) wurden die 
Comp- und Check-Sterne wie folgt identifiziert: 
 

Auswahl Stern Label AUID V (mag) 

Check 1 
BD +40 149, Gaia DR2 
369245111604163072 

92 
000-BBB-991  

9,200 

Check 2 
Gaia DR2 
369097227288973440 

93 
000-BNG-426 

9,326 

Check 3 BD +40 145 93 000-BBB-977 9,319 

Check 4 
Gaia DR2 
369072449620465152 

95 
000-BNG-427  

9,462 

Comp HD 3639 88 000-BBB-927 8,753 



Nun beginnt Muniwin mit der Photometrie der Bilddateien und liefert eine Empfehlung, 
welche Apertur, also welche Blende, bei dieser Blendenphotometrie benutzt werden soll 
(Choose aperture). Dieser Empfehlung, nämlich jene Blende, welche die geringste 
Standardabweichung aufweist, sollte nach Möglichkeit gefolgt werden. 
 

 
 
Mit der Bestätigung unter -> OK erscheint die Lichtkurve, welche von Muniwin anhand 
der gewählten Blende berechnet wird. 
 

 



Die oben dargestellte Lichtkurve zeigt den Verlauf der instrumentellen Helligkeit von CC 
And. Hier kann die Amplitude, die Lage des Minimums und des Maximums in etwa 
abgelesen werden. Auch die charakteristische Kurvenform des Lichtwechsels des 
Veränderlichen (CC And) ist deutlich erkennbar. 
Für eine Veröffentlichung dieser Lichtkurve wären aber genauere Zeitangaben und 
Helligkeitsamplituden erstrebenswert. Die Messwerte der Lichtkurve können als 
differentielle oder instrumentelle Helligkeits-/Zeit-Werte abgespeichert werden, um mit 
einer weiteren Software verarbeitet zu werden. 
Als Auswerte- und Anzeigesoftware benutzt der Autor VW das Programm Starcurve 
(Pagel o. J. [2021]). Da es sich um ein sehr komplexes und mächtiges Programm 
handelt, wird hier nur auf die Darstellung einer Lichtkurve und auf die Dokumentation 
von Minimum, Maximum sowie deren Amplituden eingegangen. 
Im Muniwin-Menü -> Plot light curve wurde ausgewählt, ob die Anzeige und 
Verarbeitung der Messwerte als differentielle oder als instrumentelle Werte vorliegen 
sollen (siehe oben). Die Software Starcurve benötigt instrumentellen Werte, deshalb 
wurden diese oben ausgewählt. 
Unter -> Light curve wird in Muniwin -> View -> Table ausgewählt. Jetzt werden alle 
Messwerte des Veränderlichen, der Referenz- und der Check-Sterne angezeigt. 
Mit -> File -> Save und einem Dateinamen, z.B. And_CC_20201218.txt wird eine Datei 
im vorgegebenen Zielordner erstellt. Als Dateityp (file type) ist C-Munipack (default) zu 
wählen. 
 

 
 
Nun starten wir StarCurve. Unter dem Menüpunkt -> = = Light curve = = -> open 
MUNIWIN-file lässt sich die Datei And_CC_20201218.txt öffnen bzw. einfügen. 
 



 
 
Die mit Muniwin erstellte Lichtkurve wird nun auf der StarCurve-Oberfläche angezeigt. 
 

 
 
Weiter werden unter -> = = Light curve = = -> S e t t i n g s Lichtkurve die notwendigen 
Parameter eingetragen. 
 



 
 
Eingabemaske von StarCurve in der Grundeinstellung, 
 

 
 
dieselbe Maske im ausgefüllten Zustand 



Wurde die StarCurve-Settings-Maske mit den Parametern ausgefüllt und mit -> 
Calculation -> OK bestätigt so ergibt sich die folgende Ansicht: 
 

 
 
Um einen Lichtkurvenzug zu erhalten, gibt es einen Menüpunkt -> = = Light curve = = -
> Fourier Approximation oder als Shortcut die Taste f. 
 
Daraufhin ergibt sich die folgende Grafik: 
 

 
 
Die im Beispiel gezeigte Lichtkurve wurde mit einer Fourier Approximation mit drei 
Frequenzen erstellt. 



Eventuell kann hier eine andere Einstellung der Frequenzen erforderlich sein. Eine 
solche Änderung kann über das Menü, aber auch mit den in der oberen Menüleiste 
vorhandenen Befehlen F+1 und F-1 erfolgen. Die Lichtkurve passt sich dann den 
Messwerten am, selbst wenn diese einer starken Streuung unterliegen. Wird die 
Frequenz geändert, so wird diese Änderung mit Drücken der Taste f in der Grafik 
aktualisiert. 
Um die Minima und Maxima in den kalibrierten Helligkeiten und zu den zugehörigen 
Zeitpunkten zu ermitteln, kann das Menü == Light curve == -> Search Maximum oder -
> Search Minimum angeklickt werden oder man benutzt das Icon mit dem roten 
senkrechten Strich auf der gelben Kurve in der oberen Menüleiste. 
 

 
 
Anhand von 216 Aufnahmen, aufgenommen mit einer spiegellosen APS-C-Kamera 
(Canon EOS M5) und einem 135-mm-Teleobjektiv, nachgeführt auf einer Skywatcher 
Star Adventurer Reisemontierung, konnte so eine Lichtkurve des Veränderlichen CC 
Andromedae mit Maximumszeitpunkt, Maximumshelligkeit, Minimumszeitpunkt und 
Minimumshelligkeit erstellt werden. 
Der Aufnahmeort für diese Aufnahmen war ein Feldweg in einer ländlichen Region 
mitten im lichtverschmutzen Ruhrgebiet. 
 
Bildüberlagerung und Ausrichtung von Fotoserien 
(unter Alinierung wird hier das Ausrichten der Aufnahmen zueinander verstanden) 
In den neueren Versionen von Muniwin ist ein weiterer Menüpunkt hinzugekommen: das 
Frame merging, auch Bildüberlagerung oder Stapelung (Stacking) genannt. Damit kann 
man eine beliebige Anzahl von Bildern zusammenfassen, z. B. wenn man nur kurz 
belichtete Aufnahmen vorliegen hat; weil die Qualität der Nachführung oder das Fehlen 
einer solchen keine längere Belichtungszeit erlaubt. Durch Stacking entstehen 
Summenbilder, die sich wie länger belichtete Aufnahmen verhalten. Das Rauschen ist 
deutlich reduziert (Wischnewski 2021, S. 203) und das Signal-Rausch Verhältnis 
verbessert, wodurch die Sterne besser erkannt bzw. Störungen seltener als Sterne 



identifiziert werden. Zudem sind genauere Messungen möglich (Wischnewski 2013). 
Werden die Summenbilder im Gleitkomma-Zahlenformat gespeichert (in Muniwin: single 
precision FP (8 bytes)), so kommen die Pixelwerte im Gegensatz zu lang belichteten 
Einzelaufnahmen nicht in die Sättigung (Wischnewski 2021, S. 204). Dadurch lassen 
sich auf solchen Fotos Sterne eines wesentlich weiteren Helligkeitsbereiches 
vermessen als auf vergleichbar lang belichteten Einzelaufnahmen. Um das Stacking 
korrekt ausführen zu können muss Muniwin die einzelnen Aufnahmen nach dem 
Referenzbild ausrichten (= alinieren). Daher kann man den Menüpunkt Frame merging 
verwenden, um eine Serie genau ausgerichteter Fotos zu erzeugen. Aus einer solchen 
Serie lässt sich mit einem astronomischen Bildbearbeitungsprogramm wie Fitswork ein 
Teilbereich ausscheiden. Eine solche Teilbereichsserie kann dann wieder als neues 
Projekt in Muniwin geladen werden. In solchen Teilbereichsserien erfolgen die 
Rechenvorgänge, wie Rauschfilter, Sternerkennung, Matching und Photometrie 
wesentlich schneller als bei voller Bildgröße. Auch ist es auf Teilbereichen einer 
Aufnahme wesentlich leichter die gesuchten Sterne zu finden, speziell wenn es sich um 
lichtschwache Sterne handelt. 
 
Um das „Frame merging“ nutzen zu können, muss man für die Photomerie anstatt der 
Projektkategorie Light curve die Kategorie CCD frame merging auswählen. Ansonsten 
ist wie oben angegeben bei Light curve zu verfahren. Die Kategorie CCD frame merging 
hat zur Folge, dass ein weiteres Menü unter dem Drop-down-Menü mit der Bezeichnung 
Make erscheint. Dieses trägt die Bezeichnung Merge frames. Zusätzlich erscheint ein 
entsprechendes, funktionsgleiches Symbol in der Symbolleiste. 
 
Zunächst wird wie oben bei Light curve beschrieben eine Express reduction 
durchgeführt. Anschließend wählt man aber nicht Plot -> Light curve, sondern Make –> 
Merge frames. Nun erscheint ein Menü, in dem man die Parameter für die 
Bildverschmelzung eingeben kann. 
 

 



Im oben dargestellten Beispiel wurden die Parameter so gewählt, dass keine Bilder 
zusammengefasst werden (merge every 1 frames, Maximum time span 300 seconds, 
merge at least 1 frames). Stattdessen werden ausgerichtete Bilder gespeichert, was 
dann an mehr oder weniger großen dunklen Rändern an manchen Seiten erkennbar ist. 
Sind bei diesen Bildern die schwarzen Randbegrenzungen nicht rechtwinklig 
zueinander ausgerichtet oder sind die Bilder gänzlich schwarz, so erfolgte nur ein 
unzureichendes Matching. In diesem Fall muss entweder der Matchingvorgang 
wiederholt werden (eine Erhöhung des FWHM-Wertes z.B. von 4 auf 6 wirkt oft Wunder) 
oder es müssen, beim Stacken mehrere Bilder, unzureichend erkannte Bilder aus dem 
Projekt entfernt werden. 
Leider spielt Muniwin die Bilder auf den Kopf gestellt (vertikal gespiegelt) aus. Entweder 
verzichtet man daher beim Einlesen der Originalbilder auf die Option „flip vertically“, 
oder man unterzieht die ausgerichteten Ausgabebilder in Fitswork einer erneuten 
Stapelbearbeitung: Datei -> Stapelbearbeitung (Anfangsdatei wählen, Alle Dateien im 
Ordner aktivieren) -> Funktion wählen -> Bild spiegeln-> Funktion wählen -> Bild 
rotieren: Grad: 180. 
Man kann den Rotationswinkel auch so wählen, dass die Bilder wie auf den Sternkarten 
ausgerichtet sind. Bei der Wahl des richtigen Winkels hilft ein vorangegangenes 
Erkennen der fotografierten Himmelsregion mit All Sky Plate Solver (Benitende o. J. 
[2021]). 
 
Diese in einem eigenen Verzeichnis abgespeicherte Bildserie kann nun in Fitswork 
geladen werden, um eine interessierende Region (ROI) auszuscheiden. Im 
vorliegenden Beispiel wollen wir die Umgebung des Veränderlichen VV Cas 
ausschneiden, der sich auf unserer Fotoserie mit den Abmessungen 6016 x 4016 Pixel 
bei Position 2237, 2112 befindet. Wir wählen den Ausschnitt so, dass alle notwendigen 
Vergleichssterne auf dem Bildausschnitt enthalten sind. 
 
In Fitswork sind dazu folgende Menüpunkte zu wählen: 
Datei -> Stapelbearbeitung (Anfangsdatei wählen, Alle Dateien im Ordner aktivieren) -> 
Funktion wählen -> Bildgeometrie -> Ausschneiden 
 



 
 
Wir erhalten jetzt eine verkleinerte Bilderserie der Ausmaße 1116 x 716, die Fitswork 
zur Unterscheidung von den Originalbildern mit dem Präfix FW_[Bildname] versieht. 
Diese verkleinerte Bilderserie können wir nun als neues Projekt (Light curve) wieder in 
Muniwin laden. Bei der Expess reduction werden nun wesentlich weniger Sterne 
gefunden, nämlich 3340 in Frame #21, welches wir als Referenzframe ausgewählt 
haben. Wir begrenzen daher die maximale Anzahl der zu ermittelnden Sterne auf 3400 
und erhalten die folgende Ausgabe: 
 

 



Natürlich kann man auch mehrere Bilder zusammenfassen, z. B. immer 10, indem man 
den Wert von merge every…frames z. B. auf 10 setzt. Hat man aber einzelne Frames 
gelöscht, weil diese z. B. verwackelt waren, so kann man verhindern, dass Bilder eines 
längeren Zeitraums vereinigt (gestackt) werden, indem man den Parameter maximum 
time span … seconds begrenzt. Wählt man bei einer Aufnahmefolge 
(Einzelbelichtungszeit und Totzeit) von 30 Sekunden einen Wert von 300, so werden 
bei Bildausfällen entsprechend weniger Bilder vereinigt. Vorteilhaft ist, dass 
Aufnahmedatum und -zeit auf den Mittelwert der Einzelaufnahmen korrigiert werden, 
der Fitsheader also im Sinne von AAVSO und BAV korrekt geschrieben wird. 
 
Es ist auch möglich, alle Bilder zu einem einzigen Summenbild zu vereinigen. Im 
Beispiel unserer oben aufgeführten Serie von CC And ergibt sich dann ein dekoratives, 
tief belichtetes Bild der Andromedagalaxie. 
 
Auswertung von Fotoserien langperiodischer Veränderlicher 
Möchte man langperiodische Veränderliche mit Muniwin photometrieren, so ergeben 
sich gegenüber „normalen“ Fotoserien einige Besonderheiten. Zum einen sind die 
einzelnen Aufnahmen nicht gleich ausgerichtet, sondern oft um einige Bogenminuten 
oder Grade gegeneinander verschoben und verdreht. Dabei sind die Bilder im 
Unterschied zu Serienaufnahmen nicht um einen etwa gleichbleibenden Abstand 
verschoben, sondern zufallsbestimmt. Auch in anderen Aufnahmeparametern 
unterscheiden sich Aufnahmen einzelner Nächte bzw. Nachtstunden sich beträchtlich 
z.B. bezüglich Durchsicht (Nebel) oder Mondschein. Daher ist es empfehlenswert die 
Aufnahmen vor der Photometrie richtig auszurichten. 
 
Bei langperiodischen Sternen werden üblicherweise kurze Aufnahmeserien von 9 
Bildern aufgenommen, die durch Bildüberlagerung (siehe oben) zu einem Summenbild 
zusammengefasst werden. Dies geschieht einerseits, um schwächere Sterne erfassen 
zu können und andererseits (aufgrund der längeren Gesamtbelichtungszeit) das 
Rauschen (Szintillationsrauschen) zu vermindern und die Messgenauigkeit zu erhöhen 
(PSF-Funktion kann besser angepasst werden, vgl. (Wischnewski 2021, S. 202–204), 
(Wischnewski 2013). Neun Bilder sind bei handelsüblichen DSLR-Kameras die maximal 
mögliche Anzahl von Einzelaufnahmen bei der Verwendung des internen 
Selbstauslösers. Je Beobachtungsnacht werden bei langperiodischen Sternen meistens 
nur wenige Aufnahmeserien angefertigt. Bei Sternen mit Perioden von einigen Wochen 
erfolgt nur eine Aufnahme pro Nacht. Bei kürzer periodischen Sternen, deren 
Lichtwechsel sich im Verlauf weniger Tage abspielt, können auch Aufnahmen im 
Abstand von wenigen Stunden oder viertelstündlich sinnvoll sein. Wenn mehrere 
Objekte parallel erfasst werden sollen, wird das fotografierte Objekt von Aufnahmeserie 
zu Aufnahmeserie gewechselt. Aus diesem Grund ist es effizienter, für die Bearbeitung 
der Bilder das Programm Fitswork (Dierks o. J. [2014]) zu verwenden. Die fertig 
bearbeiteten Bilder werden dann bis zur photometrischen Auswertung in für die 
Beobachtungobjekte erstellten Unterverzeichnissen gesammelt. 
 
Gute Einführungen zu Fitswork finden sich im Grundlagenwerk von Erik Wischnewski 
(Wischnewski 2021, 204-209, 251-252, 268-270, 409-410) sowie auf den Webseiten 
von Klaus Hohmann (Hohmann o. J. [2021a]). Dort ist auch eine Anleitung von Carsten 
Przygoda verlinkt (Przygoda o. J. [2009]). 



 
Da bei Addition im Ganzzahl-System Information verloren geht, sollten alle 
Summenbilder im 32-Bit-Gleitkomma-Fits-Format gespeichert werden (Wischnewski 
2021, S. 204). Daher muss dies zunächst in den Grundeinstellungen von Fitswork 
festgelegt werden: Einstellungen -> Datei speichern. 
 

 
 
Nachdem, wie oben beschrieben, die Lights, Darks und gegebenenfalls auch Flats 
aufgenommen wurden, werden die RAW-Dateien in Fitswork verarbeitet. Dazu erzeugt 
man zunächst einmal Masterdarks und Masterflats, was sich in Fitswork in einem 
einzigen Arbeitsschritt durchführen lässt: 
Datei -> Masterdark/-flat erstellen 
 



 
 
Je nach Menge der angefertigten Darks und Flats, lassen sich die Masterframes nach 
unterschiedlichen Verfahren berechnen. Im Gegensatz zu Muniwin, wo das 
Rechenverfahren nicht genannt wird (höchstwahrscheinlich wird gemittelt), hat man hier 
die volle Kontrolle über den Vorgang. Als Methode wäre ab 30 Aufnahmen Median, unter 
5 Aufnahmen Mitteln und dazwischen Mittelmed zu wählen (Wischnewski 2021, S. 192). 
Die vergleichenden Untersuchungen des einen Autors (JS) haben jedoch gezeigt, dass 
unabhängig von der Anzahl der Darks bzw. Flats Mitteln das beste Resultat liefert und 
sich die Aufnahme von jeweils mindestens 30 Bildern empfiehlt. Der Autor JS fertig 
jeweils sogar 45 Aufnahmen an. Es empfiehlt sich eine Bibliothek mit verschiedenen 
Darks in Abhängigkeit von ISO-Zahl, Belichtungszeit und Außentemperatur zu erstellen 
(Wischnewski 2021, S. 194). 
Neben der Wahl des Rechenverfahren gibt es noch einen weiteren Punkt, der für eine 
Kalibrierung der Bilder in Fitswork spricht: Fitswork erlaubt die Verrechnung von 
Flatdarks. Diese sollen eine weitere Steigerung der Messgenauigkeit um den Faktor 10 
ermöglichen (Wischnewski 2021, S. 201), verhindern aber auf jeden Fall, dass das 
Verstärkerglühen doppelt abgezogen wird. 



Je nach den eigenen Anforderungen sollten für Temperaturabstände im Bereich von 2-
5° jeweils eigene Masterdarks erstellt werden. Während der Aufnahmen der Objekte 
(Lights) wird die Außentemperatur sorgfältig notiert. Nach der Aufnahmenacht werden 
die Lights nach Kategorien (ISO-Zahl, Belichtungszeit, Außentemperatur) sortiert und 
die Darkabzüge und das Stacking folgendermaßen durchgeführt. 
 
Datei -> Stapelbearbeitung (Anfangsdatei wählen, Alle Dateien im Ordner aktivieren) -> 
Funktion wählen -> Bild subtrahieren (Dateiname: Datei auswählen, 
Temperaturausgleich deaktiviert, Hotpixelkorrektur aktiviert) -> Funktion wählen -> 
FarbCCD nach RGB (Dateiname: Datei auswählen). 
 

 



 
 
Die Aufnahmen werden also zugleich debayert. Dies ist vor der Bildüberlagerung 
unbedingt notwendig. Wie man die notwendige FCM-Datei erzeugt, ist bei (Hohmann o. 
J. [2021b]) unter Schema speichern beschrieben. Für gut fokussierte Aufnahmen 
empfiehlt sich „Bayer Pattern, V.N.G. Color Correction“ (Hohmann o. J. [2021b]). 
Bearbeiten -> CCD -> Farb-CCD zu RGB-Bild -> Werte einstellen, dann mit dem 
Diskettensymbol speichern. 
Einen Flatabzug kann man sich aus den oben genannten Gründen ersparen, falls man 
das Objektiv ausreichend abblendet, so dass keine Vignette sichtbar ist. 
 
Nun kommt die Bildüberlagerung an die Reihe. Dazu verschiebt man alle zu 
überlagernden Bilder in ein Unterverzeichnis und ruft die erste Datei auf: 
 
Datei -> Stapelbearbeitung (Anfangsdatei wählen, Alle Dateien im Ordner und 
Fehlenden Dateien der Serie überspringen aktivieren) -> Funktion wählen -> Zur 
Zieldatei addieren -> Anzahl Markierungen: M, Funktion: Add. 
 



 
 
Nun werden 3 Sterne als Referenz für die Verschiebung und Drehung ausgewählt. 2 
Sterne sind zumeist nicht ausreichend, 4 oder mehr können hingegen auch ausgewählt 
werden, bringen aber meist keine zusätzliche Genauigkeit. 
 

 



Anschließend erscheint das nächste Bild in diesem Verzeichnis. Falls der Versatz 
größer als die Größe der Markierungen ist, müssen die Markierungen manuell 
verschoben werden. War der Versatz aber so gering, dass die Sterne sich auch im 
nächsten Bild noch immer innerhalb der Markierung befinden, so erkennt Fitswork diese 
Sterne selbständig und verschiebt die Markierung auf den Mittelpunkt derselben. Durch 
Aktivierung der Option Keine Kontrolle mehr können dann alle Bilder des 
entsprechenden Verzeichnisses automatisch ausgerichtet und addiert werden. Aktiviert 
man diese Option, so folgen noch zwei Rückfragen, wie bei kritischen Fällen zu 
verfahren ist. Diese sind beide zu bejahen. 
 

 
 

 
 
Am Ende der Bildaddition wird das Summenbild als Zielbild.fit angezeigt und zusätzlich 
im Verzeichnis der Quellbilder abgespeichert. Man kann es nun nach Wunsch 
umbenennen. Während der Bildaddition lassen sich die Aufnahmen überprüfen und 
fehlerhafte Einzelaufnahmen bzw. Serien löschen. In der Praxis werden fehlerhafte 
Aufnahmen notiert, anschließend gelöscht (auch das Zielbild) und der 
Bildadditionsvorgang wiederholt. Die fertigen Aufnahmen lassen sich in 
Unterverzeichnissen sammeln, bis sie für die Photometrie einer Messreihe benötigt 
werden. 
 
Munwin kann mit dem Gleitkommaformat bei Fits-Bildern zwar umgehen, erwartet aber, 
dass die Helligkeitswerte durch die Anzahl der gestackten Bilder dividiert wurden. Da in 
Fitswork im Batchbetrieb aber nur eine Multiplikation möglich ist, muss daher mit dem 
Kehrwert der Bilderanzahl multipliziert werden. Damit die RGB-Summenbilder von 
Muniwin verarbeitet werden können, müssen in Fitswork die folgenden 
Bearbeitungsschritte erfolgen: 
 
Datei -> Stapelbearbeitung (Anfangsdatei wählen, Alle Dateien im Ordner aktivieren) -> 
Funktion wählen -> Pixelmathematik -> Wert multiplizieren: Faktor 0.111111 [für 9 
Bilder] -> Funktion wählen -> Farbfunktionen -> Farbbild in 3 s/w-Bilder aufteilen. 



Die Grünkanalbilder werden dann in einem Unterverzeichnis zur späteren Verwendung 
in Muniwin gespeichert. Die übrigen Bilder können gelöscht werden, außer man möchte 
auch Rot- und Blaukanäle auswerten. 
 
Nun wird in Muniwin ein neues Projekt in der Projektkategorie CCD frame merging unter 
einem passenden Namen erstellt. Bevor man nun diese Grünkanal-Bilder in Muniwin 
lädt, sollte man noch einige Voreinstellungen ändern. Zum einen Min.pixel value auf 
einen niedrigen negativen Wert (-1000) und Max. pixel value auf einen deutlich höheren 
Wert (200.000) setzen. Dies verhindert „bad Pixel“, die sonst die Erkennung gesättigter 
Sterne unterbinden und Messungen im Umfeld von schlechten Pixeln unmöglich 
machen. Bad Pixel sind durch rote Farbe im Bild erkennbar. Flip image vertically sorgt 
dafür, dass die Bilder wie in Fitswork angezeigt dargestellt werden, denn Muniwin und 
Fitswork verhalten sich in der Defaulteinstellung bei der Anzeige entgegengesetzt. 
Allerding kann dies auch in Fitswork in den Grundeinstellungen geändert werden: 
Einstellungen -> Datei laden -> FITS Dateien vertikal spiegeln. 



 
 
Die anderen Parameter stellt man wie oben beschrieben ein. Bei der Express reduction 
ist zu beachten, dass man erstens bei Fetch/convert files Grayscale wählt, weil der 
Grünkanal ja bereits extrahiert ist, und zweitens Dark-frame correction und Flat-frame 
correction deaktiviert, weil die Kalibrierung ja bereits erfolgt ist. 
 



 
 
Nachdem der Matchingprozess vollendet ist, kann man die ausgerichteten Bilder wie im 
Kapitel zur Bildüberlagerung beschrieben abspeichern und in Fitswork auf die 
interessierende Region zuschneiden. Dann werden, wie oben beschrieben, die 
zugeschnittenen Bilder als neues Projekt in Muniwin geladen und alle Schritte erneut 
durchgeführt. Dabei wird der Wert bei Threshold belassen und lediglich die Anzahl der 
zu findenden Sterne sinnvoll begrenzt. Warum? Zwar kann man den Threshold-Wert so 
verändern, dass er auf dem Referenzframe die richtigen Strukturen als Sterne erkennt, 
weil sich aber die Aufnahmen verschiedener Nächte extrem unterscheiden können, 
werden auf anderen Frames real vorhandene Sterne nicht erkannt. Mit demselben 
Threshold-Wert, der auf einem Bild über 10.000 Sterne findet, werden auf einem 
anderen nur unter hundert gefunden. Beim Matchingprozess werden dann kaum noch 
Sterne erkannt. Deshalb ist es besser zuerst nur auf dem Referenzframe durch 
Änderung des Threshold-Wertes eine plausible Sternzahl zu ermitteln. Diese lässt sich 
überprüfen, indem man den Menüpunkt Photometry auf das Referenzframe beschränkt 
und nach Abschluss des Erkennungsvorgangs dieses durch Doppelclick zur Anzeige 
lädt. Durch Einstellung der Anzeige View -> Image and chart lassen sich Foto und 
erkannte Sterne simultan anzeigen. 
 



 
 
Im oben gezeigten Beispiel wurden viele Sterne nicht erkannt. Der Threshold-Wert (hier: 
80) müsste daher wieder erniedrigt werden. Falls uns aber nur hellere Sterne 
interessieren und diese alle erkannt wurden, können wir die Zahl der erkannten Sterne 
notieren und als Begrenzung verwenden. Anschließend wird der Threshold-Wert wieder 
auf die Defaulteinstellung (4.00) zurückgesetzt. Es gibt aber noch einen anderen, 
besseren Weg die Anzahl der Sterne unter der Default-Thresholdeinstellung zu 
ermitteln. Durch Wechsel zwischen den Anzeige View -> Image only und -> Image and 
Chart kann man einen schwachen, noch klar erkennbaren Stern ermitteln. Da sehr 
lichtschwache Sterne sowieso nicht verlässlich gemessen werden können, ist es nicht 
relevant, welcher Stern gewählt wird. Unter der Anzeigeoption -> Image and chart erfolgt 
nun ein Doppelklick auf jenen Stern, so dass auf der rechten Seite die Informationen zu 
diesem Objekt angezeigt werden (object inspector). 
 



 
 
Wir erkennen ganz oben die Object-ID (#3212), die ja der Reihenfolge absteigender 
Helligkeitswerte entspricht und geben noch etwas „Sicherheit“ hinzu. Daher setzen wir 
unseren Wert für Max.Stars auf 3400, und lassen die Express reduction erneut 
durchlaufen. Die oberste Option Fetch/convert files können wir uns dabei jetzt ersparen. 
 
Die Berechnung der übrigen Bilder erfolgt jetzt wesentlich schneller. Gegenüber einem 
erhöhten Threshold-Wert wird auch eine hohe Zahl von Sternen gematcht. Es sind 
üblicherweise über 50%, außer bei sehr schlechten Aufnahmen. Bei diesem erneuten 
Berechnungsdurchgang sollte auf Bilder mit sehr geringer Matchingrate geachtet 
werden (unter 10%). Dies kann ein Hinweis darauf sein, dass das entsprechende Bild 
entweder „nicht passt“, also eine andere Himmelsregion zeigt, oder der 
Ausrichtungsprozess (z.B. durch Leuchtspuren bedingt) fehlerhaft war. Es empfiehlt 
sich daher die Bilder in Muniwin manuell „durchzublättern“, indem man wie oben 
beschrieben ein Objekt mit dem Object inspector auswählt und die Pfeile oberhalb des 
Bildausschnittes betätigt. 
 
Außerdem kann man seine Zielobjekte suchen. Durch Aufruf von Tools -> Quick 
Photometry lassen sich sowohl für die Messblende wie auch Hintergrundumfeld 
günstige Werte bestimmen. Im Hintergrundumfeld des Veränderlichen sollten sich, im 
Gegensatz zum oberen Beispiel, keine Sterne befinden. Die Messblende sollte das 
Objekt komplett umfassen. Den gefundenen Wert nimmt man dann als mittleren Wert 
(#6 oder #7) bei den Muniwin-Einstellungen der Registerkarte „Photometry“. In der 
Defaulteinstellung von Muniwin unterscheiden sich die verschiedenen Blenden etwa um 
den Faktor 1.4, was als Kriterium für die Wahl der anderen Blendenwerte (#1 bis #12) 



herangezogen werden kann. Die endgültige optimale Messblende wird allerdings erst 
mit Hilfe der Checksterne bestimmt. Ohne Auswahl eines Checksterns erscheint ein 
entsprechendes Auswahlmenü allerdings nicht. 
 
Die Darstellung von Fotos ist bei Muniwin etwas unpraktisch. Während man bei Fitswork 
das Histogramm an die Helligkeit der gesuchten Zielsterne anpassen (skalieren) kann, 
ist die große Zahl gezeigter Sterne bei Muniwin zunächst irritierend. 
 
Die weitere Vorgehensweise ist nun identisch mit jener bei kurzperiodischen 
Veränderlichen. 
 
Frame merging in Muniwin oder Fitswork durchführen? 
Rein theoretisch könnte man auch bei langperiodischen Veränderlichen alle Arbeiten, 
also auch die Bildüberlagerung, in Muniwin erledigen. Allerdings besteht dabei die 
Gefahr, schnell die Übersicht zu verlieren, wenn insgesamt mehr als 1000 Bilder aus 
über 100 Verzeichnissen in das Programm geladen werden. Theoretisch ist das zwar 
möglich, allerdings müssen diese Bilder bereits dark- und flatkorrigiert sein, da sie ja bei 
oftmals unterschiedlichen Außentemperaturen aufgenommen wurden und daher 
unterschiedliche Masterdarks und Masterflats erfordern. Durch die Parameter merge 
every…frames (sehr groß, z.B. 1000) und maximum time span … seconds (auch sehr 
groß, z.B. 40.000) könnte man dann alle Fotos nach einzelnen Nächten 
zusammenfassen. 
 
Fotografiert man in einer Nacht sehr viele unterschiedliche Objekte, so ist es allerdings 
effizienter, die Kalibrierung und das Stacking mit Fitswork durchzuführen. Gegenüber 
Muniwin ergibt sich ein Zeitvorteil, da alle Aufnahmen unterschiedlicher Objekte bei 
gleichen Parametern simultan bearbeitet werden können. 
 
Zu beachten ist allerdings, dass nur Muniwin den FITS-Header korrekt schreibt. Das 
bedeutet, dass die Belichtungszeiten korrekt aufaddiert werden und die Mitte der 
Aufnahmezeiten als neue Aufnahmezeit verwendet wird. Fitswork hingegen übernimmt 
offensichtlich die Werte des Referenzbildes. 
 
 
PSF-Photometrie mit Fitswork (PSF = Punktspreizfunktion) 
Haben wir nur wenige Aufnahmen zu photometrieren, können wir diese Aufgabe auch 
in Fitswork mit dem PSF-Verfahren erledigen. „Das PSF-Verfahren ist ein intelligentes 
Verfahren, dass dem Anwender sehr viel Arbeit abnimmt und von subjektiven Einflüssen 
wie Messfeldgröße und -lage befreit Zudem kann ihm Sättigung nicht ganz so viele 
anhaben wie der Blendenphotometrie. Es erlaubt etwa eine Größenklasse mehr 
herauszuholen.“ (Wischnewski 2021, S. 251). 
In den Einstellungen sollte dafür noch folgende Optionen aktiviert sein: Einstellungen -
> Verschiedenes: alles aktivieren, insbesondere <L> PSF Info zusätzlich in einem 
separaten Fenster anzeigen. 
 



 
 
Dann drucken wir uns wie oben beschrieben mit dem VSP (The American Association 
of Variable Star Observers o. J. [2021d]) eine geeignete Sternkarte aus, auf der wir die 
zu messenden Sterne in ihrer Reigenfolge markieren. Eine Empfehlung wäre: Erst die 
Veränderlichen, dann die Referenzsterne in abnehmender Helligkeitssequenz messen. 
Dies erleichtert später die Berechnung absoluter Helligkeiten mit dem Programmpaket 
Magreg (Spelda 2021). 
 



 
 
Jetzt suchen wir den ersten Zielstern (kleiner Pfeil) auf dem Foto und positionieren den 
Mauszeiger darauf. Das muss nicht exakt stimmen, aber der Stern sollte auf der rechten 
Seite im Vergrößerungsfenster (großer Pfeil) sichtbar sein. Die PSF-Photometrie-
Funktion sucht automatisch die Mitte des Sterns, selbst wenn man den Mauszeiger nicht 
richtig positioniert hat. Deshalb sind Messfehler weitgehend ausgeschlossen und die 
Messwerte stets reproduzierbar. Auch enge Sterne können zumeist gut getrennt 
vermessen werden. In seltenen Ausnahmefällen, wenn man einen lichtschwachen Stern 
in enger Nachbarschaft eines hellen Sternes vermessen möchte, muss man den hellen 
Stern übermalen. Erst dann ist eine korrekte Messung möglich. Nun betätigen wir die 
Taste L. Fitswork führt nun eine PSF-Photometrie durch und zeigt Koordinaten sowie 



Messwerte an. Und zwar sowohl auf der rechten Seite als auch in einer Tabelle, die jetzt 
im Vordergrund erscheint. Ein Doppelklick auf das obere Vergrößerungsfenster öffnet 
eine grafische Darstellung der PSF-Messung, die es erlaubt zu erkennen, ob sich der 
Stern in Sättigung befindet und wie gut der Gauss-Fit den Messwerten folgt. Hier können 
auch Korrekturen durchgeführt werden. Die PSF-Photometrie erlaubt nämlich auch 
noch Messungen, wenn sich der Stern leicht in der Sättigung befindet. Ist die Sättigung 
gerade erst erreicht, wird der Gauss-Fit noch immer korrekt berechnet. Falls nicht, 
empfiehlt es sich, den Wert für Überbelichtung zu erniedrigen. Zu empfehlen sind Werte 
zwischen -5 und -10. Passt der Gauss-Fit noch immer nicht, so sind noch geringere 
Werte allerdings nicht empfehlenswert. Solche Sterne sollten nicht mehr vermessen 
werden, da die Messwerte zu ungenau werden. Es werden nämlich zunehmen 
Messpunkte bei der Berechnung ausgeschlossen. Diese sind im Schaubild grau 
unterlegt, so dass man beurteilen kann, ob eine Messung noch als sinnvoll erachtet 
werden kann. Weiterführende Angaben dazu finden sich bei (Wischnewski 2021, 251-
252, 259-260, 269-270). 
 
Wenn wir alle gewünschten Sterne vermessen haben, müssen wir lediglich die 
Vordergrundtabelle markieren, mit copy/paste in ein Tabellenkalkulationsprogramm 
(z.B. Excel) übertragen und die Messwerte dort abspeichern. Am besten in ein 
Template, in dem wir die Namen und Kataloghelligkeiten der gemessenen Sterne sowie 
die Aufnahmeparameter (vor allem den Aufnahmezeitpunkt als Julianisches Datum) 
bereits eingetragen haben. Wir können diesen Vorgang mit weiteren Bildern fortsetzten 
und erhalten dann eine Datenbanktabelle mit Photometriedaten, die wir im nächsten 
Schritt auswerten können (vgl. (Spelda 2021)). Streng genommen benötigen wir von 
den Messwerten lediglich die instrumentellen Magnituden. 
 
Extinktionsausgleich 
Theoretisch müsste man die Zenit-bezogenen Kataloghelligkeiten noch auf die Höhe 
des Beobachtungsobjektes reduzieren (Wischnewski 2021, S. 256–257). In der Praxis 
kann man sich das zumeist sparen. Eigene Untersuchungen (JS) haben gezeigt, dass 
die Messgenauigkeit umso höher ist, je näher zueinander Veränderlicher und 
Vergleichssterne stehen. Benutzt man weit entfernt stehende Vergleichssterne, so sinkt 
die Messgenauigkeit stark ab, und zwar deutlich stärker als die extinktionsbedingten 
Unterschiede. Hierfür sind vermutlich Unterschiede in der Bewölkung und der 
Luftunruhe verantwortlich. Selbst in 30-40° Höhe (Testobjekt Sternbild Scutum) waren 
die extinktionsbedingten Unterschiede größer als die „lokalen Unterschiede“ auf einer 
Aufnahme mit 100 mm Brennweite und APS-C-Sensor, wobei ein Feld von 8,5 X 13° 
abgedeckt wurde. Dies lag vor allem an dem starken Abfall der Messgenauigkeit über 
die großen Distanzen. Erst bei eine Höhendistanz von ca. 15° machte sich eine 
Extinktionskorrektur positiv bemerkbar. Ein weiterer Grund für den geringen Einfluss der 
Extinktion mag die gewählte Anordnung der Vergleichssterne, nämlich kreisförmig um 
den Veränderlichen sein. Dadurch dürften sich die extinktionsbedingten Unterschiede 
weitgehen herausmitteln. 
 
Bestimmung der kalibrierten Helligkeiten 
Hat man nun die instrumentellen Helligkeiten mit einem der genannten Programme 
ermittelt, müssen noch die kalibrierten Helligkeiten errechnet werden. Dafür gibt es für 
DSLR/DSLM-Photometrie eigentlich nur ein empfehlenswertes Verfahren, die (lineare) 



Regression (vgl. auch (Wischnewski 2021, S. 549). Eine Regressionsrechnung liefert 
uns eine Formel, aus der wir die Helligkeit eines beliebigen anderen Sternes, z. B. eines 
Veränderlichen berechnen können. Diese Formel ist unabhängig von der Helligkeit 
dieses Sterns und der Helligkeitsdifferenz zu den Vergleichssternen. Die Methode 
eignet sich gleichermaßen für Blenden- und PSF-Photometrie. 
Für eine lineare Regression wurde vom einen Autor (JS) ein eigenes Programmpaket 
entwickelt (Spelda 2021). Daher kann an dieser Stelle auf die dortigen Ausführungen 
verwiesen werden. 
 
Meldung der Daten 
Haben wir erfolgreich die kalibrierten Helligkeiten unserer veränderlichen Sterne 
bestimmt, so können wir diese der Allgemeinheit zur Verfügung stellen. Dafür existieren 
2 Portale. Zum einen jenes der BAV, zum anderen jenes der AAVSO. In beiden Fällen 
ist eine Registrierung erforderlich, eine Mitgliedschaft nicht unbedingt. So kann man sich 
auch ohne Mitgliedschaft bei der AAVSO registrieren (The American Association of 
Variable Star Observers o. J. [2021a]), dabei aber zugleich, sofern zutreffend, seine 
Mitgliedschaft in der BAV oder einer anderen nationalen Organisation angeben. Nach 
der Registrierung erhält man nach einiger Zeit (über Email) ein Beobachterkürzel 
zugesandt und kann mit diesem seine Daten melden. Dies geschieht in Form einer CSV-
Datei, also einer Textdatei mit einem bestimmten, nach gewissen Rahmenbedingungen 
frei wählbarem Trennzeichen. Der Aufbau der Meldedateien gleicht sich bei AAVSO und 
BAV. Eine ausführliche Beschreibung findet sich in den BAV-Blättern (Bundesdeutsche 
Arbeitsgemeinschaft für veränderliche Sterne e. V. (BAV) 2012), so dass wir hier nicht 
weiter darauf eingehen möchten. Die Datei erstellt man am besten in einem Texteditor 
wie Notepad++ (Ho o. J. [2021]), Excel ist weniger geeignet, weil dieses Programm 
zusätzliche Trennzeichen einfügt wenn die einzelnen Zeilen eine unterschiedliche 
Anzahl an Spalten enthalten. Dies ist jedoch der Fall, weil der Anfangsteil (Header) keine 
Spalten enthält, die einzelnen Meldungszeilen hingegen schon. 
 
Bei DSLR-Photometrie sind zwei Einträgen im Header zu beachten: 
Zum einen #OBSTYPE=DSLR, zum anderen TG für den Grünkanal bzw. TB und TR für 
Blau- bzw. Rotkanal der DSLR-Kategorie. 
 
Um Daten melden zu können (The American Association of Variable Star Observers o. 
J. [2021c]) muss man auf der Webseite der AAVSO angemeldet sein, ansonsten erhält 
man einen Hinweis auf eine notwendige Registrierung (The American Association of 
Variable Star Observers o. J. [2021e]). Ist man angemeldet, so kann man eine Datei auf 
dem eigenen PC auswählen und hochlanden. Kurz darauf wird der Inhalt der Datei auf 
dem Bildschirm angezeigt und man kann nochmals kontrollieren, ob alles korrekt ist. 
Erst nach der Bestätigung werden die Daten endgültig auf den Server der AAVSO 
übertragen. Das Schöne daran ist, dass die Daten sofort verfügbar sind, allerdings nur 
im neuen Lichtkurvengenerator (enhanced LCG, (The American Association of Variable 
Star Observers o. J. [2021b]) ). Dort kann man dann seine Daten mit jenen anderer 
Bobachter vergleichen und sieht sofort, wie gut man im Vergleich zu den Kollegen 
gemessen hat. Bei beliebten Sternen, wie Mirasternen, findet man viele 
Vergleichswerte. Die Anzeige erfolgt getrennt nach Beobachtungskategorie (visuell oder 
Filterband). Man kann Kategorien ausblenden oder auch die Daten bestimmter 
Beobachter, die alle unten namentlich aufgeführt sind, hervorheben. 



 
Bei der BAV kann man seine Einzelmessungen ebenfalls melden (BAV o. J. [2021]) . 
Auch hier erhält man nach dem erfolgreichen Upload eine Bestätigung. Bei der ersten 
Meldung erhält man auch ein Beobachterkürzel. Es wird empfohlen, die Daten parallel 
an beide Portale zu melden. 
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